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1. About SpectraSmart 

SpectraSmart is a spectral measurement software program developed by OTO Photonics 

to work with portable spectrometers manufactured by OTO Photonics. It offers a wide 

variety of optical measurements including spectrum, absorbance, transmittance, 

reflectance, light source, and concentration. 
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2. Minimum System Requirements 

Before installing SpectraSmart, ensure that your computer meets the following minimum 

requirements: 

Minimum System Requirements 

Processor 1 GHz or higher 

RAM 1 GB or higher 

Hard Disk 100 MB or higher 

Screen 

Resolution 

1024 x 768 or higher 

Operating 

System 

Windows 10, Windows 8/8.1, Windows 7, Windows Vista SP1, 

Windows XP SP3 

Software Microsoft .NET Framework 3.5 
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3. Installing SpectraSmart 

Before Installation 

Before installing SpectraSmart, ensure that you have the administrator privilege to the 

computer where SpectraSmart is being installed. 

 

Windows 10/8/8.1/7/Vista Systems Need to Disable User Account Control 

First 

When installing on a Windows 10, Windows 8/8.1, Windows 7, or Windows Vista system, 

please turn off the User Account Control prior to installation to ensure proper execution 

of the setup program. You can restore the original setting after the installation. The 

following sections explain how to turn off the User Account Control. 

Windows 10 

Right-click on the Start button, and then select Control Panel from the pop-up menu: 

 

Figure 1: Right-click on the Start button, and then select Control Panel  

After the Control Panel opens, navigate to User Accounts, User Accounts, and then 

Change User Account Control Settings. Set the user account control settings to Never 

notify (as shown below). Click OK. 
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Figure 2: Turning off User Account Control on Windows 10 

 

Windows 8/8.1 and Windows 7 

Open the Control Panel from the Start menu. Navigate to User Accounts and Family 

Safety, User Accounts, and then Change User Account Control Settings. Set the user 

account control settings to Never notify (as shown below). Click OK. 

 

Figure 3: Turning off User Account Control on Windows 7 
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Windows Vista 

Open the Control Panel. Navigate to User Accounts and Family Safety. (If your computer 

is logged on to a domain, navigate to User Account.) Go to User Accounts, and then Turn 

User Account Control On or Off. Disable Use User Account Control (UAC) to help protect 

your computer (as shown below). Click OK. 

 
Figure 4: Turning off User Account Control (UAC) on Windows Vista  

 

Installing SpectraSmart Software 

Please insert the software CD into the computer, and then the installation will start. If it 

doesn't start automatically, navigate to the CD-ROM drive. Double-click on the 

"setup.exe" file to start up the setup program. 

Note: Prior to installing SpectraSmart, the setup program will check if the 

"Microsoft .NET Framework 3.5" component is installed on the system. If it is 

not installed, the following window will appear to help you install this 

component. Follow the instructions on the window to install ".NET Framework 

3.5." 
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Figure 5: Installing ".NET Framework 3.5" 

After ensuring that "Microsoft .NET Framework 3.5" is installed, the SpectraSmart setup 

program will start up a Setup Wizard to guide you through the installation process. The 

following windows will appear one by one in the listed order. Please follow the 

instructions on each one to complete the process. 

 
Figure 6: Setup Wizard--Welcome 
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Figure 7: Setup Wizard--License Agreement 

 

 
Figure 8: Setup Wizard--Select Installation Folder 
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Figure 9: Setup Wizard--Confirm Installation 

 

 
Figure 10: Setup Wizard--Installing SpectraSmart 
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Figure 11: Setup Wizard--Installation Complete 

When you see the Installation Complete window, it means that SpectraSmart has been 

successfully installed. Click Close to finish. 

Installing Device Drivers 

Normally, device drivers for supported spectrometers will be installed with SpectraSmart 

as part of the setup process. If they are not installed due to unexpected errors, you need 

to install these drivers manually. Files for these drivers will be copied to the "Driver" 

folder under the installation path for SpectraSmart during the setup. If you have selected 

the default path, the drivers will be in: 

C:\Program Files\OtO\SpectraSmart\Driver    (32-bit systems) or  

C:\Program Files (x86)\OtO\SpectraSmart\Driver   (64-bit systems) 

Under this folder, there are sub-folders for each series of spectrometers: 

SD1200/2200 Series Spectrometers (USB 1.1) 

Drivers for SD 1200/2200 Series are placed under the "USB1.1" sub-folder under the 

"Driver" folder mentioned above. Under this folder, there are two further folders: 

"Win Vista&7" and "WinXP" containing drivers for Windows 10/8/8.1/7/Vista and 

Windows XP, respectively. Please choose the appropriate drivers according to your 

operating system. 

SD1220, SE, SW, SH, and UM Series Spectrometers (USB 2.0) 

Drivers for SD1220, SE, SW, SH, and UM Series are placed under the "USB2.0" folder 
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under the "Driver" folder mentioned above. 

Steps for installing the drivers manually: 

Windows 10/8/8.1/7/Vista 

Please run the "DriverInstaller.exe" program on the CD or under the SpectraSmart 

installation folder to install the drivers. Or, you can first connect the spectrometer to your 

computer, and then go to the Device Manager to update drivers when the system cannot 

find the appropriate drivers for your device: "USBXpress Device" (for SD1200/2200 

Series) or "TAURUS" (for SD1220 Series). Specify the folder location of the appropriate 

drivers, as shown in the following figure:  

 

Figure 12: Manually specifying the location of drivers on 64-bit Windows 7 

After you have specified the path, click Next to finish driver installation. 

Windows XP 

Connect the spectrometer to your computer. When the system is unable to find the 

appropriate drivers for the device, go to the Device Manager to update the drivers for the 

device: "USB Spectrometer" (for SD1200/2200 Series) or "TARUS" (for SD1220 Series). 

Specify the folder location of the appropriate drivers, as shown in the following figure: 
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Figure 13: Manually specifying the location of drivers on Windows XP 

After you have specified the path, click Next to finish driver installation. 
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4. Removing SpectraSmart 

If you need to remove SpectraSmart, go to the Control Panel and follow the instructions 

below: 

Note:  To open the Control Panel on Windows 10, right-click on the “Start” button, and 

then select “Control Panel” from the pop-up menu. 

Windows 10/8/8.1/7/Vista 

Open the Control Panel. Navigate to Programs and then Programs and Features. Select 

SpectraSmart from the list, and then click Uninstall. The system will ask you to confirm 

the removal. After the confirmation, you will see a message box showing the removal 

progress. When it is finished, this message box will close. 
 

 
Figure 1: Confirming the removal of SpectraSmart (on Windows 10/8/8.1/7/Vista systems) 

 

Figure 2: The system is removing SpectraSmart (on Windows 10/8/8.1/7/Vista systems) 

Windows XP 

Open the Control Panel. Select Add or Remove Programs. Select SpectraSmart from the 

list, and then click Remove. The system will ask you to confirm the removal. After the 

confirmation, you will see a message box showing the removal progress. When it is 

finished, this message box will close. 
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Figure 3: Confirming the removal of SpectraSmart (on Windows XP systems) 

 

 
Figure 4: The system is removing SpectraSmart (on Windows XP systems) 
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5. Getting Started with SpectraSmart 

Starting SpectraSmart 

A shortcut to the SpectraSmart program will be placed on your computer desktop during 

the installation. See the following figure: 

 

Figure 1: SpectraSmart program shortcut on the desktop 

Do not connect the spectrometer yet! 

Double-click on this shortcut to start SpectraSmart. After it is started, you will see the 

following: 

 

Figure 2: SpectraSmart not yet connected to the spectrometer 

Next, connect the spectrometer to the computer where SpectraSmart is installed. When 

SpectraSmart detects the device, the following message will appear, indicating that the 

device is being initialized: 
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Figure 3: SpectraSmart is initializing the measurement device 

After the device is initialized, you can use the device in SpectraSmart for a wide variety of 

spectral measurements. When you see the following, it means that SpectraSmart is ready 

for measurements: 

 

Figure 4: SpectraSmart is ready for measurement 

Now, you can create a new measurement from the Measurement menu. Or, you can load 

a previously saved measurement or a set of measurement settings from the File menu. 
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If you connect the spectrometer first... 

If you connect the spectrometer to your computer before you start SpectraSmart, it will create a 

default spectrum measurement for the connected device on startup, allowing you to ensure that the 

device is working properly. See the following figure: 
 

 

Figure 5:  SpectraSmart creates a default spectrum measurement for the connected device on startup 

If there is more than one spectrometer connected to your computer when SpectraSmart starts, it will 

create a default spectrum measurement for each device connected, and there will be more than one 

device in the Device List. See the red highlighted area in the figure below. 
 

 
Figure 6: On startup, SpectraSmart creates a default spectrum measurement for each connected spectrometer 

(i.e. Spectrum_0 and Spectrum_1) 
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Device List 

When SpectraSmart recognizes the spectrometer, it will display it in the Device List pane 

on the left of SpectraSmart window, as shown in the following red highlighted area: 

 
Figure 7: The Device List of SpectraSmart 

The Device List shows the basic attributes of connected devices, such as models, serial 

numbers (SN), and wavelength ranges. 

Note:  The serial number is how SpectraSmart identifies each device. This number is 

also used in several windows where device selection is needed. For this reason, 

when you have multiple devices connected, please pay attention to their serial 

numbers so you can identify them. 

Device Information Details 

If you need to view detailed information about a connected device, go to the File menu, 

and then select Device Information, as shown in the following figure: 
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Figure 8: Selecting Device Information from the File menu 

Then, the following window appears, showing details about the device: 

 

Figure 9: Device information details 

 

Network Spectrometer  

SpectraSmart now supports WiFi wireless network spectrometers designed by OTO 

Photonics. Before using such network spectrometers in your measurements, you should 
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add them to the Device List in SpectraSmart. Please select Add Network Spectrometer 

from the File menu: 

 

Figure 10: Select Add Network Spectrometer from the File menu 

 

Next, in the Add Network Spectrometer screen that shows, you will see all the network 

spectrometers detected by SpectraSmart, as in the following picture: 

 

Figure 11: The Add Network Spectrometer screen shows all detected network spectrometers 

 

Select the network spectrometer you want to connect, and then click OK. After 

SpectraSmart has established connection with the device, you will see the network 

spectrometer in the Device List, as the following picture shows: 

 

Figure 12: The Device List shows the added network spectrometer 

 

Now, this network spectrometer is ready to use in your measurements. 
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6. Spectrum Measurement 

SpectraSmart can work with portable spectrometers manufactured by OTO Photonics to 

offer a wide variety of spectral measurements including spectrum, strip chart, absorbance, 

transmittance, reflectance, light source, and concentration. This chapter describes how to 

create basic spectrum measurements. The chapters that follow will describe how to 

create other spectrum-based measurements. 

Before the Measurement 

Before doing any measurements, you should set up the measurement environment, such 

as positioning the spectrometer on the measurement platform, connecting the light 

source to the spectrometer's input connector, placing the cuvette holder in position, etc. 

For details on how to set up the measurement environment, refer to the documentation 

of spectrometers. This document only covers the features of SpectraSmart. 

Creating a Spectrum Measurement 

To create a spectrum measurement, select Spectrum from the Measurement menu to 

open the New Spectrum window, as shown in the following: 

 

 

Figure 1: Selecting Spectrum from the Measurement menu to create a spectrum measurement 
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Figure 2: New Spectrum—Live Spectrum Settings 

On the New Spectrum--Live Spectrum Settings window, select a source device (identified 

by its serial number). Then, enter an integration time (i.e. the exposure time for the light 

sensor) and a wavelength range to display on the X-axis (the range in the parentheses 

indicates the range supported by the selected device, in this case: 300nm-1100nm). Then, 

click Next. 
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Figure 3: New Spectrum—Display Settings 

On the Display Settings window, specify whether to display the new spectrum curve in a 

new or an existing window. If this is the first spectrum measurement you create, you can 

only select a new window. If you already have other spectrum measurements, you can 

choose to display this new spectrum curve in an existing window. That way you can 

compare how two spectrum curves differ from each other. This window also allows you to 

specify a name for the window, as well as a title and a color for the spectrum curve. You 

may simply leave the default names unchanged. When all settings are done, click OK. 

SpectraSmart will display the newly created spectrum measurement as follows: 
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Figure 4: Newly created spectrum measurement (Spectrum_0) 

Spectrum List 

Whenever you create a measurement, the Spectrum List on the left-hand side of 

SpectraSmart window will show details about the underlying spectrum(s) of the created 

measurement. 

Note:  All spectral measurements, including but not limited to the spectrum 

measurement, have one or more underlying spectrums They will be listed here. 

Not Showing Human Visible Spectrum 

For the user to read the spectrum graph more easily, SpectraSmart shows human visible 

spectrum on the graph by default. If you don't want to display visible spectrum, go to the 

Settings menu, and then select Application Settings. On the Graph tab, disable Show 

human visible spectrum and click OK, as shown in the following. 

 

 
Figure 5: Selecting Application Settings from the Settings menu 
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Figure 6: Application Settings--Disabling Show human visible spectrum 

You will see the effect after you disable Show human visible spectrum, as in the 

following: 
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Figure 7: Not showing human visible spectrum on the spectrum graph 

Modifying Data Acquisition Settings 

If necessary, you can adjust the data acquisition settings after a measurement is created, 

such as the integration time, the number of scans to average, and the Boxcar width. You 

can do so with the quick adjustment toolbar right under the main menu. See the 

following red highlighted area: 

 

Figure 8: Modifying data acquisition settings 

Additionally, the three buttons (E, L, and I) to the right of the Boxcar width allow you to 

enable or disable Electronic Dark Correction, Linearity Correction, and Intensity 

Correction, respectively. Refer to “Appendix A: Spectrometer Correction Features” for 

details. The last three buttons on the right allow you to take a One Shot measurement, 

and to Start and Pause the data acquisition, respectively. Refer to “One-shot 

Measurement ” for details. 
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Data Distorted 

When you see the "Data distorted" warning (as in the following figure) while you are 

adjusting integration time: 

 

Figure 9："Data distorted" warning message 

It means the integration time you specified is too long that the peak in the raw spectrum 

data acquired by SpectraSmart has exceeded the maximum allowed value (i.e. 65535). 

The captured data is meaningless now, and the spectrum curve appears distorted. You 

need to re-adjust the integration time to allow the peak to fall within the maximum range. 

Sometimes, the spectrum curve may seem normal when you see the "Data distorted" 

warning, as in the following: 
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Figure 10: "Data distorted" warning appears on a seemingly normal curve 

This is because the curve in the graph is the result of automatic corrections. In fact, the 

raw data is out of permitted range, although its curve looks normal. That is why you still 

need to adjust the integration time until the warning message disappears. 

Note:  If you don't want to see this warning message, you can turn it off in the 

Application Settings. Please refer to "Display a Message when the Peak Value in 

the Spectrum Exceeds 65535" for details. 

Setting Integration Time Automatically by SpectraSmart 

In addition to manually specifying an integration time, you can also use a toolbar button 

to let SpectraSmart set the integration time automatically for you. Please refer to "Setting 

Integration Time Automatically" for details. 

Graph Toolbar Buttons 

Every measurement graph has a toolbar of buttons right above it. They provide quick 

access to frequently used functions. See the following figure: 
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Figure 11: Graph toolbar buttons 

These buttons are divided into two major groups: Scale Adjustment Buttons and Other 

Easy Access Buttons. 

Scale Adjustment Buttons 

By default, all measurement graphs (including spectrum graphs, strip charts, absorbance 

graphs, etc.) are created with optimal display scales for X- and Y-axes chosen by 

SpectraSmart. Sometimes, the scales may not fit your needs. So, SpectraSmart provides a 

set of toolbar buttons for you to customize the scales and display ranges. See the 

following red highlighted area: 

 

Figure 12: Scale adjustment buttons on the spectrum graph 

These buttons are explained in details in the following. 
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Scale Graph Axes Automatically 

 

Figure 13: The Scale graph axes automatically button 

This button automatically adjusts the X- and Y- axes to their optimal settings. The 

following figure shows the effect of this button. In the figure, the X-axis is adjusted to 

display the entire wavelength range supported by the device, while the Y-axis is adjusted 

so that the curve fills the entire graph as much as possible: 

 
Figure 14: The effect of using Scale graph axes automatically 
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Scale Y-axis Automatically 

 
Figure 15: The Scale Y-axis automatically button 

This button automatically adjusts the scale of Y-axis to show more details. The following 

figure shows the effect of this button. In the figure, the highest point on the curve is 

extended to the top of Y-axis: 

 
Figure 16: The effect of using Scale Y-axis automatically 
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Scale X-axis Automatically 

 
Figure 17: The Scale X-axis automatically button 

This button automatically adjusts the scale of X-axis to show more details. Using this 

button will adjust the X-axis to display the internal wavelength range of the device, as in 

the following figure: 

 
Figure 18: The effect of using Scale X-axis automatically 

Note:  If the original X-axis setting is already displaying the internal wavelength range 

of the device, pressing the "Scale X-axis automatically" button will not cause any 

change. You can try to zoom in on the graph, and then press the button to see its 

effect. 

 

www.aptechnologies.co.uk

AP Technologies Limited   The Coach House   Watery Lane   Bath   BA2 1RL 
T:  +44 (0) 1225 780400    F:  +44 (0) 8701 266449    E:  info@aptechnologies.co.uk 

http://www.otophotonics.com/


SpectraSmart User's Guide 6.Spectrum Measurement 

OTO PHOTONICS INC. 
 http://www.otophotonics.com/  Page 37 

 

Zoom In 

 
Figure 19: The Zoom In button 

This button enlarges the graph (pulling it closer to you). Here we press Scale graph axes 

automatically to restore the graph to its optimal display settings, and then press Zoom In 

to demonstrate its effect. The following figure shows the result of pressing Zoom In four 

times (to make it more apparent): 
 

 
Figure 20: The effect of pressing Zoom In 
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Zoom Out 

 
Figure 21: The Zoom Out button 

This button shrinks the graph (pushing it away from you). Here we first zoom in on the 

graph four times, and then press Zoom Out twice to demonstrate its effect. See the 

following figure: 
 

 
Figure 22: The effect of pressing Zoom Out 

Note:  Keep pressing the "Zoom Out" button will bring the graph back to its default 

settings, and the graph will not shrink any further. 
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Revert Graph Settings to Application Defaults 

 

Figure 23: The Revert graph settings to application defaults button 

 

This button restores the graph display settings to application defaults (i.e. the original 

settings when the graph is created). To demonstrate, we press this button to restore the 

graph in the former example to its default settings. See the following figure: 

 
Figure 24: The effect of reverting graph settings to application defaults 
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Graph Settings 

 

Figure 25: The Graph Settings button 

This button opens the setting details of X- and Y-axes, as shown in the following: 

 

 
Figure 26: The Graph Settings window 

The Graph Settings window allows the user to customize the minimum and maximum 

values for X- and Y-axes, as well as the size of a major step. Here we configure the X-axis 

(wavelength) range to fall within 400 to 800 (nm), with a major step of 100. Then, we 

configure the Y-axis (signal intensity) range as 0 to 50000, with a major step of 5000. See 

the following figure for the result: 
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Figure 27: Using custom X-, Y-axes 

 

Other Easy Access Buttons 

The following sections describe the other easy access buttons on the toolbar. 

Checking Spectrum Values 

The spectrum curve gives you a quick glimpse of the characteristics of the light being 

measured. In addition, you can check the actual value of a specific wavelength by placing 

the mouse cursor over a point on the curve. As shown in the following figure, we place 

the mouse cursor over the peak of the blue light area to show its actual wavelength 

(456.34) at the top of the graph and its measured intensity (29517.99) on the right of the 

graph. 
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Figure 28: Checking the value of a specific wavelength with the mouse 

Although the mouse cursor offers a handy way to check specific values, it does not let you 

see all the data at a glance. SpectraSmart provides a tabular spectrum data pane to the 

right of the spectrum graph to let you see all captured data in details, as in the previous 

figure. The upper half of the pane consists of a list of the underlying spectrum curves of 

this measurement ("Spectrum_0" is the only spectrum curve for this case). The lower half 

of the pane consists of two tabs. The first tab is the Spectrum Data tab that we want. It 

shows a scrollable table, which allows you to view the desired wavelength range by using 

the scrollbar on its right. 

Closing Spectrum Data Pane 

If you don't want to see this spectrum data pane, just click on the Show spectrum data 

button on the toolbar. This button allows you to turn this pane on or off: 

 

 
Figure 29: The Show spectrum data button 
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Figure 30: How it looks when the Spectrum Data Pane is closed 

 

Placing Marks on the Graph 

Placing Marks with the Mouse 

Although it is very handy to use the mouse cursor to check values of specific wavelengths, 

you may want to keep the values displayed on the graph so you can observe their 

variations over time or capture screenshots. SpectraSmart provides a toolbar button to 

let you place marks on the graph for this purpose: 

 

Figure 31: The Place marks on the graph button 

 

When pressed, the Place marks on the graph button allows the user to place vertical 

marks with readings on the graph by clicking the left mouse button at the positions where 
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the user wants the marks to be. Such marks can be very handy for observations and 

screenshots. See the following figure: 

 
Figure 32: The effect of placing marks on the graph 

In the figure, we have placed a mark (the red vertical bar) at the wavelength of 554.01 nm 

with a reading of 21710.43. 

Note:  When you place a mark with the mouse, the program automatically finds the 

peak value on the curve near the location you click and places the mark there. 

As such, it is better to click on the curve at the wavelength position where you 

want to observe, rather than clicking on the empty space on the graph. 

Otherwise, the mark may go to where the peak value appears, instead of the X 

position you click. 

Placing Marks with the Spectrum Data Pane 

In addition to using the mouse, you can also use the spectrum data pane to put marks on 

the graph, with the benefit of better accuracy in selecting the exact wavelengths you 

want. First, press the Show spectrum data button on the toolbar if you have closed the 

spectrum data pane: 

 

www.aptechnologies.co.uk

AP Technologies Limited   The Coach House   Watery Lane   Bath   BA2 1RL 
T:  +44 (0) 1225 780400    F:  +44 (0) 8701 266449    E:  info@aptechnologies.co.uk 

http://www.otophotonics.com/


SpectraSmart User's Guide 6.Spectrum Measurement 

OTO PHOTONICS INC. 
 http://www.otophotonics.com/  Page 45 

 

 
Figure 33: The Show spectrum data button 

The upper half of the spectrum data pane consists of a list of the underlying spectrum 

curves of this measurement ("Spectrum_0" is the only spectrum curve for this case). The 

lower half of the pane consists of two tabs. The first tab is Spectrum Data. The second tab 

is the Marks tab that we want. 

 
Figure 34: The Marks tab of the spectrum data pane 

In the Marks tab, we can see the mark we created earlier is already in the list. Now, let's 

add another mark using this tab. Please enter or select a wavelength (nm) in the 

Wavelength field, and then select the mark type you want in the Type field. The available 

mark types include Normal, Peak_Intensity, Peak_Lamda, and Peak_FWHM, which are 

explained in the following: 

Normal: Shows the intensity of the marked position 

Peak_Intensity: Shows the intensity of the nearest peak 

Peak_Lamda: Shows the wavelength of the nearest peak 
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Peak_FWHM: Shows the full width at half maximum of the 

nearest peak 

After specifying Wavelength and Type, click on the green '+' sign (i.e. the Add button). A 

new mark will appear at the specified wavelength position. See the following figure: 

 
Figure 35: Adding a mark on the Marks tab. 

Note:  Marks in SpectraSmart are spaced at a certain interval. As a result, the program 

will automatically place the mark at the interval closest to the wavelength 

position you specify. That is why, in our example, the mark appears at 452.07nm 

while the wavelength you entered was 452nm. 

Deleting Marks 

If you want to delete a mark, you can select the mark you want to delete on the Marks 

tab (multiple choices can be selected at a time), and then click on the red 'X' sign (i.e. the 

Delete button) to delete it. See the following figure: 
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Figure 36: Click the Delete button after selection. 

 
Figure 37: The effect of deleting a mark. 

Switching back to Spectrum Data Tab 

After adding or deleting marks on the Marks pane, you can click on the Spectrum Data 

tab to switch back to spectrum data pane. 
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Turning Off Marks Temporarily 

If you want to turn of the marks temporarily without deleting the marks, you can press 

the Place marks on the graph button once again to turn off marks. The marks you placed 

before will still exist when they are turned off. You can simply press Place marks on the 

graph button again to see them. 

Statistical information 

Change the wavelength range to get the information 

Statistic Information gives you very clear characteristic of the spectrum under test, for 

example: Average, Min, Max & Centorid, and if you want to check the exact data for a 

particular wavelength range, by changing the calculated wavelength range, you can read 

the information data in the table depends on your selection. As the picture shown below, 

we change the wavelength range to 500-600 nm, and then we can read the current 

Average, Min, Max & Centorid in the table: 

 
Figure 38: Statistics Information shows the information after changing the wavelength range 

Smoothing 

A raw spectrum curve tends to be jagged and spiky, due to the inevitable noises in the 

original signal. SpectraSmart provides a feature to eliminate such noises and smooth out 

the curve. This is a button called Smoothing on the graph toolbar. See the following 
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figure: 

 

 
Figure 39: The Smoothing button 

Pressing this button opens the Smoothing Settings window: 

 
Figure 40: The Smoothing Settings window  

On the Smoothing Settings window, SpectraSmart offers four smoothing filters: DWT 

denoise filter ,Savitzky-Golay filter, FFT filter, Kalman filter, and High pass filter. You can 

enable one or all of them. 

 

Note: Most examples in this chapter have turned on the DWT denoise filter & 

Savitzky-Golay filter with its default settings, i.e. "11 points" and "Reference & 

Measurement Curve." If all filters are disabled, the spectrum curve should look 

like the following: 
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Figure 41: The result of disabling "Smoothing"  

With smoothing disabled, the spectrum curve looks jagged. 

 

Showing Peak Values 

Sometimes you need to know the peak values on the curve when you are viewing a 

measurement graph. SpectraSmart provides a feature to automatically identify the peaks 

and show their values on the graph. Here is the button to show the peak values: 

 

Figure 42: Peak button 

When pressed, the Peak button opens the Peak Information window:  
 

 

www.aptechnologies.co.uk

AP Technologies Limited   The Coach House   Watery Lane   Bath   BA2 1RL 
T:  +44 (0) 1225 780400    F:  +44 (0) 8701 266449    E:  info@aptechnologies.co.uk 

http://www.otophotonics.com/


SpectraSmart User's Guide 6.Spectrum Measurement 

OTO PHOTONICS INC. 
 http://www.otophotonics.com/  Page 51 

 

 

Figure 43: The Peak Information window 

To enable this feature, select Find and show peaks on the graph, and then specify the 

Width of the peak searching window as well as a minimum value for the peak (i.e. Find 

peaks above the value of). Peak values are identified by scanning the entire curve with a 

fixed width of wavelength as a moving window to search for the highest value within that 

window. As a result, scanning with a wider window means to find a peak within a wider 

wavelength range, leading to fewer peaks found because a value needs to stand out in a 

wider range to be qualified as a peak. And, the minimum value further limits the lowest 

boundary of the peak. In this example, we set the width of the searching window as 100 

nm and the minimum value as 40000. Click OK, and you will see the following result: 

 
Figure 44: The result of enabling Peak Information 

As the former figure shows, SpectraSmart identifies a peak near 452 nm and displays its 

precise values: "452.07 : 43452.52." The number before the colon (:) indicates where the 

peak value appears, i.e. at the wavelength of 452.07nm. The number after the colon is 
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the peak value itself: 43452.52. It is the intensity of the light detected by the sensor, 

converted into the output range of the sensor. It is a pure value and not associated with 

any unit of measurement. 

Moreover, although the curve in this case appears to have two peaks, the one at around 

550 nm (with an intensity of 22000 or so) is not identified by SpectraSmart because we 

have specified a minimum value of 40000 and hence have ruled out that one. If we lower 

the minimum value to 5000, there will be two peak values on the graph, as shown in the 

following: 

 
Figure 45: The result of lowering the minimum peak value (i.e. Find peaks above the value of) to 5000 
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Saving the Current Spectrum Measurement 

Saving Individual Spectrum Curves from the Toolbar 

If you want to save the current spectrum measurement to a file for future reference, you 

can use the Save selected spectrum as button on the toolbar. See the following figure: 

 

Figure 46: The Save selected spectrum as button 

Pressing this button shows the Select Spectrum window for you to choose the spectrum 

curve that you want to save: 

 

Figure 47: The Select Spectrum window 

This design allows the user to choose an individual spectrum curve to save when there 

are more than one spectrum curves in the same window. Please select the desired 
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spectrum curve, and then specify a Wavelength resolution, which includes: Default, 

0.1, ..., 0.9, 1, 5, and 10. You can simply choose Default unless you have special needs. 

When all selections are done, click OK. Next, the Save As window appears, which allows 

you to specify the destination folder and the filename (with ".sps" as the default 

extension name). See the following figure: 

 
Figure 48: The Save As window 

After specifying the desired folder and filename (default to the spectrum title), click Save 

to save the spectrum curve to a file. By default, SpectraSmart saves the file in its native 

format (.sps). You can also save the file in CSV format for later use with other software. To 

save the file in CSV format, please select “csv files (*.csv)” for the Save as type in the 

Save As window. 

Note:  SpectraSmart will not be able to read this CSV file. The CSV file can only be 

imported into other software. 

Saving Individual Spectrum Curves from the Spectrum Data Pane 

In addition to saving spectrum curves from the Save selected spectrum as toolbar button, 

you can also save individual spectrum curves from the spectrum data pane. The upper 

half of the pane consists of a list of the underlying spectrum curves of this measurement. 
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Click on the spectrum curve that you want to save, and then right-click in the list to open 

the pop-up menu. Next, select Save selected spectrum as. See the following figure: 

 
Figure 49：Selecting Save selected spectrum as on the pop-up menu 

Next, the Save As window will appear. As in the previous section, please specify the 

destination folder and the filename, and then press Save to save the spectrum as a file. 

 

Saving All Spectrum Curves in the Current Window 

SpectraSmart allows you to display a new spectrum curve in an existing window when 

you create the spectrum measurement so that you can do comparisons. Accordingly, if 

you have two or more spectrum curves in a window, you might want to save them all at 

once, instead of saving them individually. First, press the Show spectrum data button on 

the toolbar (if you have closed the spectrum data pane). Right-click in the Spectrum list of 

the upper half of the spectrum data pane to open the pop-up window, and then select 

Save all spectrums in. See the following figure: 
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Figure 50：Selecting Save all spectrums in on the pop-up menu 

Next, you will see the Browse For Folder window, which allows you select the destination 

folder for the spectrums to be saved: 

 

Figure 51: The Browse For Folder window 

When all selections are done, click OK. Then, you will see that all spectrums in the current 

measurement are saved as individual files in the specified folder. The filenames will be 

their spectrum titles, and the file extensions will always be ".sps" (in our example here, 

the saved file is "Specturm_0.sps"). 
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Saving the Current Spectrum Curve as a Temporary Log 

In addition to saving spectrum curves as files, SpectraSmart allows you to save the 

current spectrum curve as a temporary log. It is like a snapshot of the current state, and it 

is kept in the same measurement graph for your reference. For example, we can create a 

spectrum graph to measure the spectrum of a certain light source. Then, under the same 

conditions, we switch in another light source to observe the differences between the two 

light sources. To demonstrate, here we create a spectrum graph to measure the spectrum 

of a white LED light source. We save its spectrum curve as a temporary log. Then, we 

switch in another light source, also a white LED, to compare their difference. Here is the 

spectrum of the first white LED: 

 
Figure 52: The spectrum of the first white LED 

Next, right-click on the Spectrum list in the spectrum data pane to bring up the pop-up 

menu, and then select Save as temporary log. See the following figure: 
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Figure 53: Selecting Save as temporary log on the pop-up menu 

 

Next, you will see a Please enter the temporary log spectrum name message box, as in 

the following: 

 

Figure 54: Please enter the temporary log spectrum name message box 

You can specify a name for the temporary log spectrum or simply use the default number 

as the name. Here we change the number to "SpectrumOfFirstWhiteLED." See the 

following figure: 
 

 

Figure 55: Renaming the temporary log spectrum as "SpectrumOfFirstWhiteLED" 

Press OK. A new spectrum curve will be created in the spectrum graph (i.e. the 

"Log_SpectrumOfFirstWhiteLED"): 
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Figure 56: A new spectrum curve called "Log_SpectrumOfFirstWhiteLED" appears in the list 

You will not see any changes on the graph because two spectrum curves now completely 

overlap. Next, for easier observation, go to Settings, Application Settings, and then 

Graph to turn off Show human visible spectrum. See the following figure: 
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Figure 57: Turning off Show human visible spectrum 

 

 
Figure 58: The effect of turning off Show human visible spectrum 
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Next, switch the light source to the second white LED, and the result looks like this: 

 
Figure 59: The result of switching the light source to the second white LED 

As you can see in the figure, although both are white LEDs, two light sources may still be 

different in their spectrums. The thinner line on the graph is the temporary log we saved 

earlier (i.e. Log_SpectrumOfFirstWhiteLED), while the bolder line is the current 

Spectrum_0 (i.e. the spectrum curve of the second LED). When you are done with the 

temporary log spectrum, you can delete it from the spectrum data pane. Refer to 

"Deleting Individual Spectrum Curves" for details. 

Loading a Previously Saved Spectrum Curve 

Sometimes you might need to load a previously saved spectrum curve to compare with 

the current spectrum curve being captured to see their differences. For demonstration 

purpose, we keep our sample spectrum measurement ("Spectrum_0") on the screen but 

place a blue filter glass in front of the light source to modify its color. The acquired 

spectrum then changes accordingly as the following figure shows: 
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Figure 60: Using a blue filter glass to modify the current spectrum curve 

Next, we load the spectrum file we saved earlier (i.e. "Spectrum_0.sps"). Go to the File 

menu, and then select Open Spectrum File: 

 

Figure 61: Opening a previously saved spectrum by selecting Open Spectrum File from the File menu 

The Open Existing File window will appear: 
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Figure 62: New Spectrum─Open Existing File 

Use the Browse button next to the File to open field to locate the file we saved earlier 

("C:\Save\Spectrum_0.sps"). Then, click Next, and the Display Settings window will 

appear: 
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Figure 63: New Spectrum─Display Settings 

On the Display Settings window, choose Select existing window to load the spectrum 

curve into the current "Spectrum_0" window. This allows us to see two superimposed 

spectrum curves so that we can compare their differences easily. Additionally, specify an 

obvious name ("Previously_Saved_Spectrum") for the spectrum to be loaded so that we 

can recognize it right away (see the red highlighted area in the former figure). Click OK 

and you will see something like: 
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Figure 64: Loading the previously saved spectrum curve to compare with the current spectrum curve 

As it shows in the figure, the previously saved spectrum curve (the orange line) covers the 

full range of visible spectrum, because we measured a white-color light source in that 

example, while the current spectrum "Spectrum_0" only covers the range of blue light, 

since we have a blue filter glass in front of the light source right now. Let us turn off the 

Show human visible spectrum feature (see "Not Showing Human Visible Spectrum") to 

make the differences more apparent: 

 
Figure 65: Turning off the Show human visible spectrum feature to make spectrum curve comparison easier 
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Deleting Individual Spectrum Curves 

When there are more than one spectrum curves in a spectrum graph, you can delete the 

curve that is no longer needed. Here we demonstrate the steps to delete the curve we 

loaded in our previous example. First, in the Spectrum list of the spectrum data pane, 

select "Previously_Saved_Spectrum."  

 

Figure 66: Select "Previously_Saved_Spectrum" in the spectrum data pane 

Right-click in the spectrum data pane to open the pop-up menu, and then select Delete 

from the menu. See the following figure: 

 
Figure 67: Right-clicking in the Spectrum list to open the pop-up menu, and then select Delete 

This will delete the selected spectrum curve. See the following figure: 
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Figure 68: The "Previously_Saved_Spectrum" is now deleted 

 

Printing and Previewing a Spectrum Measurement 

In addition to saving the spectrum measurement to a file, you can also print it out to 

preserve it. To print the current spectrum measurement, you can use the Print Preview or 

the Print button on the toolbar. See the following figure: 

 

Figure 69: The Print Preview button 

 

Figure 70: The Print button 

Pressing the Print Preview button displays a standard Print Preview window, which 

shows the current spectrum measurement in SpectraSmart: 
 

 

www.aptechnologies.co.uk

AP Technologies Limited   The Coach House   Watery Lane   Bath   BA2 1RL 
T:  +44 (0) 1225 780400    F:  +44 (0) 8701 266449    E:  info@aptechnologies.co.uk 

http://www.otophotonics.com/


SpectraSmart User's Guide 6.Spectrum Measurement 

OTO PHOTONICS INC. 
 http://www.otophotonics.com/  Page 68 

 

 

Figure 71: The Print Preview window 

You can zoom in to check the details and make sure this is the way you like it. Click the 

printer icon on the upper-left corner of the Print Preview window to start printing. If you 

don't need to preview the graph before you print it, you can simply press the Print button 

on SpectraSmart's graph toolbar to open the standard Print window: 
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Figure 72: The Print window 

The File menu also provides the Print and the Print Preview options, and they open the 

same windows as the corresponding toolbar buttons, so we will not repeat the details 

again. In addition, the File menu also provides a Page Setup option: 

 

Figure 73: Choosing Page Setup from the File menu 

This feature lets you select the desired paper, orientation, and margins:  

 
Figure 74:  The Page Setup window 
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Lamp Control 

SpectraSmart can control the on/off states of an external light source via I/O signals. The 

lamp control button is right on the toolbar: 

 

Figure 75: The Lamp button 

The Lamp button works just like a toggle switch. Pressing it once makes it active. Pressing 

it again makes it inactive. The following figure shows the states of the button: 

 
Figure 76: The Lamp button in active and inactive states 

Spectrum Scanning Interval 

By default, SpectraSmart captures continuous spectrum data at an interval determined by 

the user-specified integration time plus around 30 ms, depending on the processor speed 

inside the spectrometer device and the performance of the computer running the 

SpectraSmart software. As a result, if the user-specified integration time is 50 ms, the 

spectrum data will be captured once every 80 ms. However, the user can modify this 

interval if necessary. You can find the Spectrum Scanning Interval button on the graph 

toolbar: 

 
Figure 77: The Spectrum Scanning Interval button 

Pressing the Spectrum Scanning Interval button shows the Spectrum Scanning Interval 
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window: 

 

Figure 78: The Spectrum Scanning Interval window (at 1000 ms) 

Select Enable user-defined spectrum scanning interval, and then specify the desired 

Interval in the text box. Click OK when done. After the change, you will notice that the 

spectrum graph refreshes at a different speed. If you set the interval to 1000 ms, as in our 

example, the graph will refresh approximately once every second. 

Setting Integration Time Automatically 

You need to specify an integration time (i.e. the exposure time for the light sensor) when 

you create a spectrum graph. Sometimes, you may not know the best integration time to 

use for the optimal result. For this, you can create the spectrum graph with the default 

setting (i.e. 50 ms), and then use the Set integration time automatically button on the 

toolbar to let SpectraSmart determine and set the optimal integration time for you. The 

new setting will reflect on the graph after you press the button. See the following figures: 

 

Figure 79: The Set integration time automatically button 
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Figure 80: The effect of using the Set integration time automatically button 

As the figure shows, the integration time has changed from 50 ms to 45 ms after the Set 

integration time automatically button is pressed. And the entire curve also shifts slightly 

downward. 

Seting as Dark Spectrum  

There is a button called Set as dark spectrum to the right of the Set integration time 

automatically button: 

 

Figure 81: The Set as dark spectrum button 

Please refer to "Setting a New Reference Spectrum or Dark Spectrum" for details on its 

purpose. 

FWHM  

SpectraSmart offers the function of displaying FWHM in real time. You can click the 

FWHM button and click on any wavelength of the spectrum. The program will 

automatically find the highest peak nearby and measure its FWHM and reflect it in the 
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spectrum as following shown: 

 
Figure 82: The FWHM button 

 
Figure 83: The result by clicking on the FWHM function button 

 

Switching X-axis Unit of Measurement (nm/cm-1)  

In addition to Wavelength (nm), SpectraSmart also supports Wavenumber (cm-1) as the 

unit of measurement for the X-axis. You can switch between them from the toolbar. See 

the following: 

 

Figure 84: Changing unit of measurement for the X-axis 

The following figure shows the result of switching to Wavenumber (cm-1): 
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Figure 85: The result of switching to Wavenumber (cm-1) 

 

Copying Spectrum Data to Clipboard  

Sometimes you might want to copy and paste the spectrum data into other applications. 

You can do this by using the Copy to clipboard button on the toolbar: 

 

Figure 86: The Copy to clipboard button 

As you press this button, all data in the spectrum data pane will be copied to the system 

clipboard. You can then paste the data into the application you want. For illustration, we 

paste the data into Windows Notepad and Microsoft Excel in the following figures: 
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Figure 87: Pasting spectrum data into Windows Notepad 

 
Figure 88: Pasting spectrum data into Microsoft Excel 

One-shot Measurement  

In most cases, SpectraSmart would be used to capture continuous real-time spectrum 
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data. In some cases, however, you might just need to get a single reading from the 

spectrometer. You can use the One Shot button above the toolbar to do this. See the 

following figure: 

 
Figure 89: The One Shot, Start Acquiring, and Pause buttons 

Before you do a one-shot measurement, you need to suspend the continuous data 

capturing using the neighboring “Pause” button, and then press the “One Shot” button 

to make it work. Each time you press the One Shot button, SpectraSmart will capture a 

spectrum reading from the spectrometer. To resume continuous capturing, press the 

Start Acquiring button next to it. 

 

Closing a Measurement 

Whenever you are done with a measurement, including spectrum, strip chart, 

absorbance, etc., you can close it by clicking on the X button on the upper-right corner of 

the graph: 
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Figure 90: The button to close a measurement 

Note: When you close the graph, the measurement is also closed. If you need the 

same measurement later (such as spectrum), you need to create it again. 

Closing All Measurements Together 

In addition, SpectraSmart also provides a Close All Measurements option, which is handy 

when you need to close multiple measurements together. Please go to the File menu, and 

then select Close All Measurements: 

 

Figure 91: Selecting Close All Measurements from the File menu 

All measurements will be closed after you select the option. 

 

www.aptechnologies.co.uk

AP Technologies Limited   The Coach House   Watery Lane   Bath   BA2 1RL 
T:  +44 (0) 1225 780400    F:  +44 (0) 8701 266449    E:  info@aptechnologies.co.uk 

http://www.otophotonics.com/


SpectraSmart User's Guide 7.Strip Chart (Tracking Specific Wavelengths) 

OTO PHOTONICS INC. 
 http://www.otophotonics.com/  Page 78 

 

7. Strip Chart (Tracking Specific Wavelengths) 

After you create a spectrum measurement, you might want to monitor a specific 

wavelength or wavelength range for a period of time to see how the reading varies over 

time. To do so, you need a strip chart. First, create a spectrum measurement by following 

the instructions in the previous chapter. See the following figure: 

 
Figure 1: Creating a spectrum measurement first 

Next, create the strip chart. Please go to the Measurement menu and select Strip Chart 

to open the New Strip Chart window: 

 
Figure 2: Selecting Strip Chart from the Measurement menu 

Next, the New Strip Chart window appears: 
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Figure 3: New Strip Chart—Strip Chart Settings 

In the New Strip Chart--Strip Chart Settings window, select the desired source spectrum 

(i.e. the spectrum to monitor). In this example, we select the spectrum that we just 

created: "Spectrum_0." Next, select the wavelength or wavelength range to monitor (in 

this case: 452.07nm). Then, specify the tracking speed, i.e. the Tracking interval. You can 

choose to synchronize the tracking speed with the source spectrum's data acquisition 

speed. That is, each time the spectrum data is acquired, the software takes one reading 

for the strip chart. You can also specify the tracking interval in terms of spectrum scans 

(every certain number of scans) or in terms of milliseconds. When all selections are done, 

click Next. 
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Figure 4: New Strip Chart—Display Settings 

Now, on the Display Settings window, specify whether you want to display the new strip 

chart in a new window or an existing window. If this is the first strip chart you create, you 

can only select a new window. If you have any existing strip chart, you can display the 

new strip chart in the existing window for comparison. This window also allows you to 

specify a name for the window, as well as a title and a color for the curve. When all 

settings are done, click OK. SpectraSmart will display the newly created strip chart, as in 

the following figure: 
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Figure 5: The newly created strip chart (Strip_Chart_0) 

The former figure shows a strip chart of about 30 seconds of data. When you create a 

strip chart, SpectraSmart automatically determines the optimal scale for the Y-axis so that 

the data can be presented clearly. The strip chart continuously records data. By default, 

the strip chart shows only 2 minutes of data. Once it accumulates more than 2 minutes of 

data, the entire chart will start scrolling to the left. See the following figure: 

 
Figure 6: The chart starts scrolling after two minutes 
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You can see that the X-axis now starts at 18:36:28, already different from the original 

position (18:36:27) when the chart was created. 

Tracking Multiple Wavelengths on a Single Strip Chart 

Since SpectraSmart allows you to create a new strip chart in an existing window, you can 

track intensity variations of multiple wavelengths on a single strip chart. Here we add 

another curve to the strip chart that we created in the previous example, tracking 

wavelength 557.27 nm (the purple curve). See the following figure: 

 

Figure 7: Tracking multiple wavelengths on a single strip chart 

Note:  You may not be able to see the second strip chart curve right away when you 

add it to the chart, because the display scale is still optimized for the first curve. 

Press the "Scale graph axes automatically" button, and you will see both curves 

(as in the former figure). 

We can also put marks on the corresponding source spectrum graph (see "Placing Marks 

on the Graph") to verify the readings of the wavelengths being tracked by the strip chart, 

as shown in the following: 
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Figure 8: Using marks on the source spectrum graph as a crosscheck for the monitored wavelengths on the strip 

chart 

Graph Toolbar Buttons 

As in the spectrum measurement, you can tailor the axes scales of the strip chart to your 

needs, as well as saving and printing the strip chart. These features are also on the 

toolbar of the strip chart as buttons. See the red highlighted area in the following figure: 

 

Figure 9: The toolbar buttons of the strip chart 
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Scale Adjustment Buttons 

In terms of scale adjustment, there are two differences between the spectrum 

measurement and the strip chart. First, the strip chart has a unique button that can 

temporarily freeze the chart (the Strip Chart View button). Second, the Scale X-axis 

automatically button is replaced by a control for specifying the time period for data 

display. These two controls are described in the following, while other buttons with the 

same functions will not be explained again. 
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Strip Chart View 

 
Figure 10: The Strip Chart View button 

This button allows you to freeze the strip chart. As the strip chart emulates the action of a 

physical strip of paper recording continuous data from left to right, the graph will scroll to 

the left as it charts new data at end of the graph. Pressing this button temporarily freezes 

the scrolling so that you can examine the data closely. When you are finished, you can 

press the button again to unfreeze it. Freezing the strip chart will not stop it from 

capturing new data. The software will keep recording new data in the background, so you 

will see continuous data when you unfreeze the chart. 

A strip chart has two states ("active" and "inactive"), which you can tell from the 

appearance of this button. When a strip chart is active, this button has a blue border 

around it. When the strip chart is inactive, it lacks the border. See the following figure: 

 

Figure 11: The "active" and "inactive" states of the Strip Chart View button 
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Time Period for Data Display (X-axis) 

 

Figure 12: The control for modifying the time period for data display 

This field allows you to specify the length of time for data display in the strip chart. By 

default, the chart shows two minutes of data. The following figure demonstrates the 

result of changing it to one minute: 

 
Figure 13: Changing the time period for data display to one minute 

Other Easy Access Buttons 

Other toolbar buttons work exactly the same way they do for the spectrum measurement. 

For details, refer to "Other Easy Access Buttons" in the chapter of spectrum 

measurement. 

Saving a Strip Chart 

Saving a strip chart follows a similar procedure for saving a spectrum measurement. For 

details, refer to "Saving the Current Spectrum Measurement" in the chapter of spectrum 

measurement. 
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Loading a Previously Saved Strip Chart Curve 

If you need to load a previously saved strip chart curve, you can follow the same steps for 

loading a saved spectrum curve. For details, refer to "Loading a Previously Saved 

Spectrum Curve" in the chapter of spectrum measurement. 

Deleting Individual Strip Chart Curves 

When you have multiple curves on the same strip chart, you might want to delete one of 

them. You delete individual strip chart curves in the same way you delete spectrum 

curves. For details, refer to "Deleting Individual Spectrum Curves" in the chapter of 

spectrum measurement. 

Printing and Previewing a Strip Chart 

The steps for printing and previewing a strip chart are the same as in printing and 

previewing a spectrum measurement. For details, refer to "Printing and Previewing a 

Spectrum Measurement" in the chapter of spectrum measurement. 
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8. Absorbance Measurement 

Spectrum-based absorbance measurement captures the spectrum of a light source after 

it passes through the test object, and then compares the acquired spectrum with the light 

source's original spectrum to come up with the absorbance curve of the test object. As 

such, the user needs to first set up the measurement environment, measure the original 

spectrum of the light source, and then put the test object in place and measure the 

spectrum of the light passing through the object. SpectraSmart provides a straightforward 

procedure to measure absorbance. All you have to do is follow the step-by-step windows 

to create an absorbance measurement. 

Creating an Absorbance Measurement 

To create an absorbance measurement, please select Absorbance from the 

Measurement menu to open the New Absorbance Measurement window, as shown in 

the following: 

 

Figure 1: Selecting Absorbance from the Measurement menu to create a new absorbance measurement 

Then, you will see the following window: 
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Figure 2: New Absorbance Measurement—Source Device 

Selecting a Source Device 

On the Source Device window, please select a source device (identified by its serial 

number). Then, click Next. 
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Figure 3: New Absorbance Measurement—Acquisition Parameters 

Specifying Integration Time 

Next, specify the integration time (i.e. the exposure time for the light sensor) on the 

Acquisition Parameters window. By default, the software automatically sets an 

integration time when this window opens, but this may not fit you needs. If required, you 

can use the preview graph on the lower half of this window to help you determine an 

appropriate integration time. This preview graph updates in real-time as you change the 

integration time. For best results, it is recommended that you specify an integration time 

to allow the highest peak of the curve to fall within the Suggested peak value range. As in 

the figure above, we allow the highest peak to fall within the suggested 40000-60000 

range. 

Note:  Here, the preview curve has only applied "Electronic Dark Correction" and 

"Linearity Correction" but not "Intensity Correction." So, it may look different 

from the curve in the spectrum measurement because the curve in the spectrum 

measurement has also applied "Intensity Correction." 
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After a few trials and errors, if you still decide that the default value might be the best 

choice, you can simply click Auto Configuration to revert to the original default setting. 

Once the integration time is set, you can continue to set the spectrum scanning interval if 

you need. Please click the Scanning Interval button. On the Spectrum Scanning Interval 

window, select Enable user-defined spectrum scanning interval, and then specify the 

interval you want (the default is 500ms), as in the following: 

 

Figure 4: Spectrum Scanning Interval 

Smoothing 

In addition to the integration time and the scanning interval, you can also choose 

whether to smooth out the curve. This allows you to avoid aberrations in the spectrum 

data by scanning multiple times for averaging. Also, SpectraSmart provides a Boxcar filter 

for additional smoothing. You can use Boxcar width to specify a number of data points on 

both side of the point of interest to include in the calculation of the moving average. This 

smooths out the sharp variations on the curve: the bigger the Boxcar width, the smoother 

the curve. The following figure demonstrates the smoothing effect of a Boxcar width of 10 

(maximum value). You can compare it with the former curve without smoothing to see 

the difference (see the red curve in the preview graph): 
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Figure 5: New Absorbance Measurement—the smoothing effect 

 

Note: The following example uses the default settings, i.e. no smoothing (Number of 

scans to average=1, Boxcar width=0). 

When all acquisition parameters are set, click Next. 
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Figure 6: New Absorbance Measurement—Reference Spectrum 

Setting Reference Spectrum 

Next, you need to set a "reference spectrum," which is basically the spectrum of the light 

source before you put the test object in place. Here, you can click on the color patch on 

the window to acquire the live spectrum as the reference. Or, you can use the Browse 

button to load a previous reference spectrum file you saved with SpectraSmart. In this 

example, we use the default option, that is, acquiring the current live spectrum of the 

light source (as such, please don't put the test object in place). Once the reference 

spectrum is captured, you will see it in the preview graph on the lower half of this 

window. Then, click Next. 
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Figure 7: New Absorbance Measurement—Dark Spectrum 

Setting Dark Spectrum 

In addition to the reference spectrum, the software also needs know the readings of the 

light sensor when it is not exposed to light to establish a baseline, i.e. the "dark 

spectrum." So, please cut off or block the light source connected to the spectrometer. 

Then, click on the black-and-white patch on the window to acquire the dark spectrum. 

You can specify the number of scans to average to avoid aberrations of individual scans. 

The default is 1, and we use 10 for example here. Once the dark spectrum is acquired, 

you will see it in the spectrum graph on the lower half of the window, as in the former 

figure. In addition, you will see an "Acquiring dark spectrum..." message window. See the 

following figure: 

 
Figure 8: Acquiring dark spectrum... 
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Aside from capturing the real-time dark spectrum, you can also select the program's 

default dark spectrum or load a previous dark spectrum file you saved with SpectraSmart. 

Please note that the default dark spectrum is a set of built-in data which is handy for 

testing purposes. It may not be suitable for your current measurement environment. The 

following figure shows the case when you choose to Use default dark spectrum: 

 

Figure 9: New Absorbance Measurement—Using the default dark spectrum 

Note:  This example uses the dark spectrum captured in real-time (not the default dark 

spectrum). 

Once the dark spectrum is set, click Next. 
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Figure 10: New Absorbance Measurement—Display Settings 

Display Settings 

Next, you can specify a name for the measurement graph window, as well as a spectrum 

title and a color for the graph, as in the former figure. To specify the color, you can click 

on the color patch and select the desired color from the palette: 
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Figure 11: Display Settings—Color 

When you are done with the display settings, click OK, and then SpectraSmart will display 

the measurement graph. See the following figure: 

 
Figure 12: Newly created absorbance measurement graph 

As we haven't put the test object in place, the absorbance across the visible spectrum is 

virtually 0. In addition, since we are using a white LED as the reference light source, and 

its spectrum covers the range from 430 nm to 750 nm, we can adjust the display range to 

430 nm to 750 nm to make the subsequent graphs look cleaner (see "Graph Settings" for 
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details). The graph after the adjustment looks like the following: 

Figure 13: Newly created absorbance measurement graph with display range adjusted to the wavelength range of 

white LED 

Start Measuring the Absorbance of the Test Object 

After the measurement graph is created, you can start measuring the absorbance of the 

test object. Here we measure the absorbance curve of a white translucent glass for 

demonstration. Its absorbance measurement graph looks like the following: 

 
Figure 14: The absorbance graph of a white translucent glass 
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As the former figure shows, its curve covers the entire range of spectrum because a white 

translucent glass basically absorbs all visible light. 

Instead, if we measure a blue filter glass, we will see lower absorbance in the blue light 

area than other areas (meaning more blue light passes through the filter glass). See the 

following figure: 

 
Figure 15: The absorbance graph of a blue filter glass 

Checking the Acquired Spectrum Curve 

Since the absorbance curve is calculated based on the spectrum acquired by the software, 

SpectraSmart provides a feature for the user to see the original acquired spectrum curve 

so it can be verified against the absorbance curve. Click on the Acquired Spectrum button 

on the toolbar to enable this feature, as shown in the following figure: 

 

Figure 16: The Acquired Spectrum button 

The following three figures show the absorbance graphs with their acquired spectrums 

for the original light source, the white translucent glass, and the blue filter glass, 

respectively: 
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Figure 17: The acquired spectrum of the absorbance measurement for the original light source 

 
Figure 18: The acquired spectrum of the absorbance measurement for the white translucent glass 
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Figure 19: The acquired spectrum of the absorbance measurement for the blue filter glass 

As we can see in the figures above, the acquired spectrum curve of the white translucent 

glass is clearly lower than that of the original light source. The magnitude of the 

difference represents the absorbance of the glass. In the case of the blue filter, the curve 

covers only the wavelength range of blue light, because the rest of spectrum is mostly 

(even if not all) absorbed by the filter. 

Graph Toolbar Buttons 

The toolbar buttons above the absorbance measurement graph are similar to those on 

the spectrum measurement graph, so we will not repeat the details here. But we would 

like to demonstrate the effect of the Smoothing button, because it works quite well with 

absorbance measurement graphs. 

Smoothing 

In the example for the blue filter glass, the absorbance curve appears to be jagged. This 

can be improved by turning on the smoothing feature. We click the Smoothing button on 

the toolbar right above the graph to turn it on: 
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Figure 20: The Smoothing Settings window 

Here we enable the Savitzky-Golay filter and select 11 points for the smoothing Degree. 

Then, click OK to see its effect: 

 
Figure 21: Enabling Smoothing effect for the absorbance graph of the blue filter glass 

As the figure shows, smoothing has made the curve more continuous and smoother. 
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Measurement Mode Switching Buttons 

In addition to the toolbar buttons described in the chapter of spectrum measurement, 

the absorbance, transmittance, and reflectance measurements all have a set of 

measurement mode switching buttons: 

 
Figure 22: Measurement mode switching buttons 

When measuring absorbance, transmittance, and reflectance, SpectraSmart allows you to 

switch among four measurement modes: S (spectrum), A (absorbance), T (transmittance), 

and R (reflectance). Therefore, this set of buttons is available on the toolbar of these 

three measurement graphs. The following four figures show the absorbance graphs of the 

blue filter glass in four different modes (S, A, T, R), respectively: 

 
Figure 23: Mode switching─S (spectrum) mode button 
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Figure 24: Mode switching─A (absorbance) mode button 

 
Figure 25: Mode switching─T (transmittance) mode button 
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Figure 26: Mode switching─R (reflectance) mode button 

As these figures show, the S (spectrum) mode actually corresponds to the "acquired 

spectrum" of the absorbance measurement. Since we are using the blue filter glass as our 

example, its curve in the blue light area appears very prominent. On the other hand, T 

(transmittance) and R (reflectance) modes appear to show the same curve, which looks 

like the opposite of the absorbance curve. This is because the absorbance mode 

measures the amount of light absorbed by the filter glass, while the transmittance mode 

measures the light passing through the filter. So they are exactly the opposite. Moreover, 

the reflectance mode measures the light reflected from the test object, it virtually equals 

to the remaining light after being absorbed by our test object. That's why the reflectance 

curve and the transmittance curve look very similar. 

Setting a New Reference Spectrum or Dark Spectrum  

In some cases, the user may need to set a new reference spectrum or a new dark 

spectrum for the current measurement. It would be too much trouble to re-create the 

measurement just because the reference or the dark spectrum needs to be changed. 

SpectraSmart provides two buttons on the toolbar for the user do this on the fly. See the 

following figure: 
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Figure 27: Set as reference spectrum and Set as dark spectrum buttons 

These two buttons work in similar manners. All you have to do is switch the current 

reference light source to the new light source, and then press Set as reference spectrum. 

The spectrum captured from the new light source will now be the new reference 

spectrum. Similarly, you can simply block the current light source or switch to another 

light source as the baseline, and then press Set as dark spectrum to capture and set the 

new dark spectrum. 

 

Basically, whenever a measurement needs a reference spectrum to work, the Set as 

reference spectrum button will appear on the toolbar. This includes measurements for 

absorbance, transmittance, reflectance, and concentration. Likwise, whenever a 

measurement needs a dark spectrum to work, the Set as dark spectrum button will 

appear. This includes measurements for spectrum, absorbance, transmittance, 

reflectance, light source, and concentration. 

Saving an Absorbance Measurement 

Saving an absorbance measurement is similar to saving a spectrum measurement, except 

that the spectrum measurement only has a single spectrum curve, while the absorbance 

measurement contains four spectrum curves: the reference spectrum, the dark spectrum, 

the absorbance curve, and the acquired spectrum. 

 

The toolbar button Save selected spectrum as only saves one spectrum curve at a time. 

To save all the spectrum curves in a measurement, you need to use the Save all 

spectrums in option in the pop-up menu of the spectrum data pane. Once saved, you will 

see all four spectrum curves in the destination folder. See the following figure: 

 

www.aptechnologies.co.uk

AP Technologies Limited   The Coach House   Watery Lane   Bath   BA2 1RL 
T:  +44 (0) 1225 780400    F:  +44 (0) 8701 266449    E:  info@aptechnologies.co.uk 

http://www.otophotonics.com/


SpectraSmart User's Guide 8.Absorbance Measurement 

OTO PHOTONICS INC. 
 http://www.otophotonics.com/  Page 107 

 

 

Figure 28: Saving all spectrums in an absorbance measurement using the Save all spectrums in option 

For more details, please refer to "Saving the Current Spectrum Measurement" in the 

chapter of spectrum measurement. 

Loading a Previously Saved Spectrum Curve of an Absorbance 

Measurement 

To load a previously saved spectrum curve of an absorbance measurement, please follow 

the same steps for loading a previously saved spectrum curve. As in the case of loading a 

spectrum curve, you can only load one spectrum curve at a time. For details, please refer 

to "Loading a Previously Saved Spectrum Curve" in the chapter of spectrum 

measurement. 

Deleting Individual Spectrum Curves of an Absorbance 

Measurement 

An absorbance measurement is composed of multiple spectrum curves. As such, please 

don't delete any individual curve from the measurement as they function as one. Doing 

so will destroy the entire measurement. 

Printing and Previewing an Absorbance Measurement 

The steps for printing and previewing an absorbance measurement are the same as in 

printing and previewing a spectrum measurement. So, we will not repeat the details here. 

Please refer to "Printing and Previewing a Spectrum Measurement" in the chapter of 

spectrum measurement. 
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9. Transmittance Measurement 

Spectrum-based transmittance measurement captures the spectrum of a light source 

after it passes through the test object, and then compares the spectrum with the light 

source's original spectrum to come up with the transmittance curve of the test object. 

Accordingly, as in the absorbance measurement, the user needs to first set up the 

measurement environment, measure the original spectrum of the light source, and then 

put the test object in place and measure the spectrum of the light passing through the 

object. SpectraSmart provides a straightforward procedure to measure transmittance. All 

you have to do is follow the step-by-step windows to create a transmittance 

measurement. 

Creating a Transmittance Measurement 

To create a transmittance measurement, please select Transmittance from the 

Measurement menu to open the New Transmittance Measurement window, as shown in 

the following: 

 

Figure 1: Selecting Transmittance from the Measurement menu to create a new transmittance measurement 

Then, you will see the following window: 
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Figure 2: New Transmittance Measurement—Source Device 

Selecting a Source Device 

On the Source Device window, please select a source device (identified by its serial 

number). Then, click Next. 
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Figure 3: New Transmittance Measurement—Color Parameters 

 

Setting Color Parameters 

When measuring transmittance, we can specify a viewing angle of the CIE Standard 

Observer (Observer angle) and the type of the light source (Illuminant) for accurate color 

measurement. SpectraSmart supports two standard observer viewing angles: 2-degree 

and 10-degree (corresponding to CIE 1931 and CIE 1964 standards, respectively), plus a 

number of standard light sources, as shown in the former figure. Here we choose 

2-degree and D65, and then click Next. 
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Figure 4: New Transmittance Measurement—Acquisition Parameters 

Specifying Integration Time 

Next, specify the integration time (i.e. the exposure time for the light sensor) on the 

Acquisition Parameters window. By default, the software automatically sets an 

integration time when this window opens, but this may not fit you needs. If required, you 

can use the preview graph on the lower half of this window to help you determine an 

appropriate integration time. This preview graph updates in real-time as you change the 

integration time. For best results, it is recommended that you specify an integration time 

to allow the highest peak of the curve to fall within the Suggested peak value range. As in 

the figure above, we allow the highest peak to fall within the suggested 40000-60000 

range. 

Note:  Here, the preview curve has only applied "Electronic Dark Correction" and 

"Linearity Correction" but not "Intensity Correction." So, it may look different 

from the curve in the spectrum measurement because the curve in the spectrum 

measurement has also applied "Intensity Correction." 

 

www.aptechnologies.co.uk

AP Technologies Limited   The Coach House   Watery Lane   Bath   BA2 1RL 
T:  +44 (0) 1225 780400    F:  +44 (0) 8701 266449    E:  info@aptechnologies.co.uk 

http://www.otophotonics.com/


SpectraSmart User's Guide 9.Transmittance Measurement 

OTO PHOTONICS INC. 
 http://www.otophotonics.com/  Page 112 

 

After a few trials and errors, if you still decide that the default value might be the best 

choice, you can simply click Auto Configuration to revert to the original default setting. 

Once the integration time is set, you can continue to set the spectrum scanning interval if 

you need. Please click the Scanning Interval button. On the Spectrum Scanning Interval 

window, select Enable user-defined spectrum scanning interval, and then specify the 

interval you want (the default is 500ms), as in the following: 

 

Figure 5: Spectrum Scanning Interval 

Smoothing 

In addition to the integration time and the scanning interval, you can also choose 

whether to smooth out the curve. This allows you to avoid aberrations in the spectrum 

data by scanning multiple times for averaging. Also, SpectraSmart provides a Boxcar filter 

for additional smoothing. You can use Boxcar width to specify a number of data points on 

both side of the point of interest to include in the calculation of the moving average. This 

smooths out the sharp variations on the curve: the bigger the Boxcar width, the smoother 

the curve. The following figure demonstrates the smoothing effect of a Boxcar width of 10 

(maximum value). You can compare it with the former curve without smoothing to see 

the difference (see the red curve in the preview graph): 
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Figure 6: New Transmittance Measurement—the smoothing effect 

 

Note:  The following example uses the default settings, i.e. no smoothing (Number of 

scans to average=1, Boxcar width=0). 

When all acquisition parameters are set, click Next. 
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Figure 7: New Transmittance Measurement—Reference Spectrum 

Setting Reference Spectrum 

Next, you need to set a "reference spectrum," which is basically the spectrum of the light 

source before you put the test object in place. Here, you can click on the color patch on 

the window to acquire the live spectrum as the reference. Or, you can use the Browse 

button to load a previous reference spectrum file you saved with SpectraSmart. In this 

example, we use the default option, that is, acquiring the current live spectrum of the 

light source (as such, please don't put the test object in place). Once the reference 

spectrum is captured, you will see it in the preview graph on the lower half of this 

window. Then, click Next. 
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Figure 8: New Transmittance Measurement—Dark Spectrum 

Setting Dark Spectrum 

In addition to the reference spectrum, the software also needs know the readings of the 

light sensor when it is not exposed to light to establish a baseline, i.e. the "dark 

spectrum." So, please cut off or block the light source connected to the spectrometer. 

Then, click on the black-and-white patch on the window to acquire the dark spectrum. 

You can specify the number of scans to average to avoid aberrations of individual scans. 

The default is 1, and we use 10 for example here. Once the dark spectrum is acquired, 

you will see it in the spectrum graph on the lower half of the window, as in the former 

figure. In addition, you will see an "Acquiring dark spectrum..." message window. See the 

following figure: 

 
Figure 9: Acquiring dark spectrum... 
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Aside from capturing the real-time dark spectrum, you can also select the program's 

default dark spectrum or load a previous dark spectrum file you saved with SpectraSmart. 

Please note that the default dark spectrum is a set of built-in data which is handy for 

testing purposes. It may not be suitable for your current measurement environment. The 

following figure shows the case when you choose to Use default dark spectrum: 

 

Figure 10: New Transmittance Measurement—Using the default dark spectrum 

 

Note:  This example uses the dark spectrum captured in real-time (not the default dark 

spectrum). 

Once the dark spectrum is set, click Next. 
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Figure 11: New Transmittance Measurement—Display Settings 

Display Settings 

Next, you can specify a name for the measurement graph window, as well as a spectrum 

title and a color for the graph, as in the former figure. To specify the color, you can click 

on the color patch and select the desired color from the palette: 
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Figure 12: Display Settings—Color 

 

When you are done with the display settings, click OK, and then SpectraSmart will display 

the measurement graph. See the following figure: 

 
Figure 13: Newly created transmittance measurement graph 

The curve over the range of visible spectrum represents the current transmittance curve. 

Since we haven't placed the test object, you can see that the transmittance is almost 

100% throughout the range. In addition, since we are using a white LED as the reference 
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light source, and its spectrum covers the range from 430 nm to 750 nm, we can adjust the 

display range to 430 nm to 750 nm to make the subsequent graphs look cleaner (see 

"Graph Settings" for details). The graph after the adjustment looks like the following: 

 
Figure 14: Newly created transmittance measurement graph with display range adjusted to the wavelength range of 

white LED 

Start Measuring the Transmittance of the Test Object 

Next, we put the test object in place to measure its transmittance. Here we measure the 

transmittance curve of a white translucent glass for demonstration. Its transmittance 

measurement graph looks like the following: 
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Figure 15: The transmittance graph of a white translucent glass 

The original curve with 100% transmittance now drops to the level of about 50%, as 

shown in the figure. This is the transmittance curve of the white translucent glass. Its 

curve covers the entire range of visible spectrum because a white translucent glass 

basically allows all visible light to pass through. Instead, if we measure a blue filter glass, 

we will see the transmittance of the blue light area is particularly higher. See the 

following figure: 

 
Figure 16: The transmittance graph of a blue filter glass 
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Checking the Acquired Spectrum Curve 

Since the transmittance curve is calculated based on the spectrum acquired by the 

software, SpectraSmart provides a feature for the user to see the original acquired 

spectrum curve so it can be verified against the transmittance curve. Click on the 

Acquired Spectrum button on the toolbar to enable this feature, as shown in the 

following figure: 

 

Figure 17: The Acquired Spectrum button 

The following three figures show the transmittance graphs with their acquired spectrums 

for the original light source, the white translucent glass, and the blue filter glass, 

respectively: 
 

 
Figure18: The acquired spectrum of the transmittance measurement for the original light source 
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Figure 19: The acquired spectrum of the transmittance measurement for the white translucent glass 

 
Figure 20: The acquired spectrum of the transmittance measurement for the blue filter glass 

As we can see in the figures above, the white translucent glass allows all visible light to 

pass through, while the blue filter glass allows most of the blue light to pass through. 
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Checking Colorimetry Information  

When measuring transmittance, reflectance, and light source, SpectraSmart also provides 

colorimetry information in addition to the measurement graph and the Acquired 

Spectrum. You can click on the Colorimetry button along the right edge of the spectrum 

data pane to open the Colorimetry pane. See the following figure: 

 
Figure 21: The Colorimetry button and the Colorimetry pane 

As in the figure above, this window shows details about the Acquired Spectrum, including 

standard observer's viewing angle, illuminant, CIE X, Y, Z coordinates, etc. 

Colorimetry Toolbar Buttons 

There are a few toolbar buttons on the top of the colorimetry pane. They are: Save, Save 

Log, Interval, Reset Log, and Show Strip Chart. See the figure below: 

 

Figure 22: Colorimetry toolbar buttons 
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These buttons are explained in the following. 

1. Save: This button allows you to save the current colorimetry information to a plain 

text (TXT) file. Its content is exactly like what you see in the previous figure. 

2. Save Log: This button allows you to keep track of colorimetry changes over a 

period of time by saving SpectraSmart's internal log of accumulated colorimetry 

data to a file. 

3. Interval: This setting allows you to set the update interval for the colorimetry 

information. 

4. Reset Log: This button allows you to clear the current internal log kept by 

SpectraSmart and start a new log. When you want to observe continuous 

colorimetry changes over a period of time, you can first clear the internal log by 

using the Reset Log button. Then, at the end of the observation period, press the 

Save Log button to save what is captured during this period to a text file. 

5. Show Strip Chart: This button allows you to keep track of a single colorimetry 

value and see its changes over time. For example, if you want to observe the 

changes of the X coordinate, you first click on this value in the table, and then click 

the Show Strip Chart button to show a pop-up window with a strip chart that 

tracks the changes of this value over time. See the figure below:  
 

 

Figure 23: The strip chart for tracking colorimetry information 

Comparing Colorimetry Information  
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Figure 24: Comparing colorimetry information 

 

The Comparison tab in the Colorimetry Information pane allows you to input standard 

values for the fields you want to observe. This way, you can see the deviation of current 

measured values from standard values. SpectraSmart will calculate the Delta (i.e. the 

deviation) for you. 

Note:  In the Comparison table, only those fields with Standard values entered will 

have Delta values calculated for them. 

Checking Diagrams 

In addition to colorimetry information, SpectraSmart also provides CIE and TM 30-15 

diagrams for the user to check the color coordinates and the dominant wavelength of the 

test object. Press the CIE Diagram button along the right edge of the measurement graph 

to enable this feature. See the figure below: 
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Figure 25: The CIE Diagram button and the CIE Diagram pane 

 

Switching between CIE and TM30-15 Diagrams 

SpectraSmart provides four types CIE diagrams: CIE 1931 ,CIE 1976, TM 30-15 Rf & Rg and 

TM 30-15 Color Vector Graphic. You can switch between them by clicking the respective 

tab. 

 
Figure 26: CIE 1931,CIE 1976, TM 30-15 Rf & Rg and TM 30-15 Color Vector Graphic diagram switching tabs 
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Figure 27: The CIE 1976 diagram 

 
Figure 28：The TM 30-15 Rf,Rg diagram 
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Figure 29：The TM 30-15 Color Vector Graphic diagram 

 

 

CIE Diagram Toolbar Buttons 

The CIE 1931 diagram provides a toolbar with a few function buttons: Save as image, 

Print Preview, Print, and CCT Quad, as shown in the following: 

 

Figure 30: The CIE Diagram toolbar 

Saving CIE and TM 30-15 Diagrams 

The Save as image button saves the currently displayed CIE diagram (CIE 1931 or CIE 

1976) or TM 30-15 diagram (TM 30-15 Rf,Rg or TM 30-15 Color Vector Graphic) to an 

image file. Pressing this button shows a standard Save As window. Specify the destination 

folder and the filename, and then press Save to save the file. See the following: 
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Figure 31: Pressing Save as image opens the Save As window 

Printing CIE Diagrams or TM 30-15 diagram 

The Print Preview and Print buttons allow you to preview and print the currently 

displayed CIE diagram or TM 30-15 diagram. When pressed, they show the standard Print 

Preview and Print dialogs, respectively, so we will not repeat the details here. 

CCT Quad 

The CCT Quad button allows you to show correlated color temperature (CCT) lines on the 

CIE 1931 diagram (not applicable to the CIE 1976 diagram and TM 30-15), as shown in the 

following: 
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Figure 32: Showing correlated color temperature (CCT) lines on the CIE diagram 

 

Graph Toolbar Buttons 

Calculated Color Range 

Sometimes the user only wants to observe a particular color range, instead of the entire 

visible spectrum, when conducting a transmittance, reflectance, or light source 

measurement. In such cases, the Calculated Color Range button can be used to specify 

the wavelength range to be observed, so that SpectraSmart will only calculate the color 

measurement curve in that range. To limit the range of color calculation, press the 

Calculated Color Range button. See the following figure: 

 

Figure 33: The Calculated Color Range button  

Select Limit the wavelength range for color calculation, and then specify the range in 

Wavelength range. See the following figure: 
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Figure 34: Specifying Calculated Color Range 

Here we use the range from 400 nm to 500 nm as an example. Press OK, and the 

measurement graph will only display the curve within that range: 

 
Figure 35: The effect of specifying calculated color range 

Other than the Calculated Color Range button, the toolbar buttons above the 

transmittance measurement graph are mostly identical to those on the absorbance 

measurement graph, and they work the same way, so we will not repeat the details here 

for those identical ones. Please refer to "Graph Toolbar Buttons" in the chapter of 

absorbance measurement. 

Saving a Transmittance Measurement 

Saving a transmittance measurement follows the same steps for saving an absorbance 

measurement, so we will not repeat the details here. Please refer to "Saving an 

Absorbance Measurement" in the chapter of absorbance measurement. 

Loading a Previously Saved Spectrum Curve of a Transmittance 
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Measurement (And Calculate Colorimetry Info ) 

Loading a spectrum curve of a transmittance measurement is similar to loading that of an 

absorbance measurement, with the same limitation(s), but there is one little difference. 

When loading a spectrum curve from a transmittance measurement, the user can specify 

whether to calculate colorimetry information: 

 
Figure 36: Choosing Calculate colorimetry information when loading a spectrum curve of a transmittance 

measurement  

 

As the former figure shows, after selecting Calculate colorimetry information, you need 

to specify Observer angle and Illuminant next. With this information provided, you will 

be able to see corresponding data in the Colorimetry and CIE Diagram panes. Apart from 

this difference, all other details are identical to loading a spectrum curve of an 

absorbance measurement. We will not repeat them here. Please refer to "Loading a 

Previously Saved Spectrum Curve of an Absorbance Measurement" in the chapter of 

absorbance measurement. 
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Deleting Individual Spectrum Curves of a Transmittance 

Measurement 

A transmittance measurement is composed of multiple spectrum curves. As such, please 

don't delete any individual curve from the measurement as they function as one. Doing 

so will destroy the entire measurement. 

Printing and Previewing a Transmittance Measurement 

The steps for printing and previewing a transmittance measurement are the same as in 

printing and previewing a spectrum measurement. So, we will not repeat the details here. 

Please refer to "Printing and Previewing a Spectrum Measurement" in the chapter of 

spectrum measurement. 
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10. Reflectance Measurement 

Spectrum-based reflectance measurement captures the spectrum of a light source after it 

reflects from the test object, and then compares the spectrum with the light source's 

original spectrum to come up with the reflectance curve of the test object. Accordingly, as 

in the absorbance measurement, the user needs to first set up the measurement 

environment, measure the original spectrum of the light source, and then put the test 

object in place and measure the spectrum of the light reflected from the object. 

SpectraSmart provides a straightforward procedure to measure reflectance. All you have 

to do is follow the step-by-step windows to create a reflectance measurement. 

Creating a Reflectance Measurement 

To create a reflectance measurement, please select Reflectance from the Measurement 

menu to open the New Reflectance Measurement window, as shown in the following: 

 

Figure 1: Selecting Reflectance from the Measurement menu to create a new reflectance measurement 

Then, you will see the following window: 
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Figure 2: New Reflectance Measurement—Source Device 

Selecting a Source Device 

On the Source Device window, please select a source device (identified by its serial 

number). Then, click Next. 
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Figure 3: New Reflectance Measurement—Color Parameters 

Setting Color Parameters 

When measuring reflectance, we can specify a viewing angle of the CIE Standard 

Observer (Observer angle) and the type of the light source (Illuminant) for accurate color 

measurement. SpectraSmart supports two standard observer viewing angles: 2-degree 

and 10-degree (corresponding to CIE 1931 and CIE 1964 standards, respectively), plus a 

number of standard light sources, as shown in the former figure. Here we choose 

2-degree and D65, and then click Next. 

 

Specifying Standard White Reflectance  

When measuring reflectance, you can choose whether to specify a standard white 

reflectance curve (a white calibration file). If you choose not to specify it, SpectraSmart 

will assume standard white to have 100% reflectance and calculate the relative 

reflectance (instead of absolute reflectance) of the measured object accordingly. If you 

 

www.aptechnologies.co.uk

AP Technologies Limited   The Coach House   Watery Lane   Bath   BA2 1RL 
T:  +44 (0) 1225 780400    F:  +44 (0) 8701 266449    E:  info@aptechnologies.co.uk 

http://www.otophotonics.com/


SpectraSmart User's Guide 10.Reflectance Measurement 

OTO PHOTONICS INC. 
 http://www.otophotonics.com/  Page 137 

 

specify the standard white reflectance curve, SpectraSmart will calculate the absolute 

reflectance of the measured object. 

 

To specify a white calibration file, click on the Browse button and navigate to your white 

calibration file. After it is specified, you will see the white calibration curve in the preview 

chart. See the following figure: 

 
Figure 4: New Reflectance Measurement—White Calibration 

The following figure shows the format of a white calibration file. The first field represents 

the wavelength, and the second field represents the reflectance. The reflectance is 

specified with numbers between 0 and 1.0, for 0% and 100%, respectively. 

 
Figure 5: The format of a white calibration file 

 

Note:  The default setting (i.e. no white calibration file) is used in our following 

example. 
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Figure 6: New Reflectance Measurement—Acquisition Parameters 

Specifying Integration Time 

Next, specify the integration time (i.e. the exposure time for the light sensor) on the 

Acquisition Parameters window. By default, the software automatically sets an 

integration time when this window opens, but this may not fit you needs. If required, you 

can use the preview graph on the lower half of this window to help you determine an 

appropriate integration time. This preview graph updates in real-time as you change the 

integration time. For best results, it is recommended that you specify an integration time 

to allow the highest peak of the curve to fall within the Suggested peak value range. As in 

the figure above, we allow the highest peak to fall within the suggested 40000-60000 

range. 

Note:  Here, the preview curve has only applied "Electronic Dark Correction" and 

"Linearity Correction" but not "Intensity Correction." So, it may look different 

from the curve in the spectrum measurement because the curve in the spectrum 

measurement has also applied "Intensity Correction." 
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After a few trials and errors, if you still decide that the default value might be the best 

choice, you can simply click Auto Configuration to revert to the original default setting. 

Once the integration time is set, you can continue to set the spectrum scanning interval if 

you need. Please click the Scanning Interval button. On the Spectrum Scanning Interval 

window, select Enable user-defined spectrum scanning interval, and then specify the 

interval you want (the default is 500ms), as in the following: 

 

Figure 7: Spectrum Scanning Interval 

Smoothing 

In addition to the integration time and the scanning interval, you can also choose 

whether to smooth out the curve. This allows you to avoid aberrations in the spectrum 

data by scanning multiple times for averaging. Also, SpectraSmart provides a Boxcar filter 

for additional smoothing. You can use Boxcar width to specify a number of data points on 

both side of the point of interest to include in the calculation of the moving average. This 

smooths out the sharp variations on the curve: the bigger the Boxcar width, the smoother 

the curve. The following figure demonstrates the smoothing effect of a Boxcar width of 10 

(maximum value). You can compare it with the former curve without smoothing to see 

the difference (see the red curve in the preview graph): 
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Figure 8: New Reflectance Measurement—the smoothing effect 

 

Note:  The following example uses the default settings, i.e. no smoothing (Number of 

scans to average=1, Boxcar width=0). 

When all acquisition parameters are set, click Next. 
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Figure 9: New Reflectance Measurement—Reference Spectrum 

Setting Reference Spectrum 

Next, you need to set a "reference spectrum," which is basically the spectrum of the light 

source before you put the test object in place. Here, you can click on the color patch on 

the window to acquire the live spectrum as the reference. Or, you can use the Browse 

button to load a previous reference spectrum file you saved with SpectraSmart. In this 

example, we use the default option, that is, acquiring the current live spectrum of the 

light source (as such, please don't put the test object in place). Once the reference 

spectrum is captured, you will see it in the preview graph on the lower half of this 

window. Then, click Next. 
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Figure 10: New Reflectance Measurement—Dark Spectrum 

Setting Dark Spectrum 

In addition to the reference spectrum, the software also needs know the readings of the 

light sensor when it is not exposed to light to establish a baseline, i.e. the "dark 

spectrum." So, please cut off or block the light source connected to the spectrometer. 

Then, click on the black-and-white patch on the window to acquire the dark spectrum. 

You can specify the number of scans to average to avoid aberrations of individual scans. 

The default is 1, and we use 10 for example here. Once the dark spectrum is acquired, 

you will see it in the spectrum graph on the lower half of the window, as in the former 

figure. In addition, you will see an "Acquiring dark spectrum..." message window. See the 

following figure: 

 
Figure 11: Acquiring dark spectrum... 
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Aside from capturing the real-time dark spectrum, you can also select the program's 

default dark spectrum or load a previous dark spectrum file you saved with SpectraSmart. 

Please note that the default dark spectrum is a set of built-in data which is handy for 

testing purposes. It may not be suitable for your current measurement environment. The 

following figure shows the case when you choose to Use default dark spectrum: 

 

Figure 12: New Reflectance Measurement—Using the default dark spectrum 

 

Note:  This example uses the dark spectrum captured in real-time (not the default dark 

spectrum). 

Once the dark spectrum is set, click Next. 
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Figure 13: New Reflectance Measurement—Display Settings 

Display Settings 

Next, you can specify a name for the measurement graph window, as well as a spectrum 

title and a color for the graph, as in the former figure. To specify the color, you can click 

on the color patch and select the desired color from the palette: 
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Figure 14: Display Settings—Color 

When you are done with the display settings, click OK, and then SpectraSmart will display 

the measurement graph. See the following figure: 

 
Figure 15: Newly created reflectance measurement graph 

As we haven't put the test object in place, the reflectance across the entire graph is 

virtually 0%. In addition, since we are using a white LED as the reference light source, and 

its spectrum covers the range from 430 nm to 750 nm, we can adjust the display range to 

430 nm to 750 nm to make the subsequent graphs look cleaner (see "Graph Settings" for 
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details). The graph after the adjustment looks like the following: 

 
Figure 16: Newly created reflectance measurement graph with display range adjusted to the wavelength range of 

white LED 

 

Start Measuring the Reflectance of the Test Object 

Next, we put the test object in place to measure its reflectance. Here we measure the 

reflectance curve of a silver color metal plate for demonstration. Its reflectance 

measurement graph looks like the following: 
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Figure 17: The reflectance measurement graph of a silver color metal plate 

In the figure, the part of the curve in the range of visible light is the reflectance curve of 

this silver color metal plate. Overall, it maintains at about 75% across the range. Its curve 

covers the entire range of visible spectrum because a silver color metal plate basically 

reflects all visible light. 

Next, we measure the reflectance curve of another metal plate painted with metallic red 

color. Its curve shows a high reflectance for red light (48%) and low reflectance from blue 

through green light (2%). See the following figure: 
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Figure 18: The reflectance measurement graph of a metallic red metal plate 

 

Checking the Acquired Spectrum Curve 

Since the reflectance curve is calculated based on the spectrum acquired by the software, 

SpectraSmart provides a feature for the user to see the original acquired spectrum curve 

so it can be verified against the reflectance curve. Click on the Acquired Spectrum button 

on the toolbar to enable this feature, as shown in the following figure: 

 

Figure 19: The Acquired Spectrum button 

The following three figures show the reflectance graphs with their acquired spectrums for 

the original light source, the silver color metal plate, and the metallic red color metal 

plate, respectively: 
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Figure 20: The acquired spectrum of the reflectance measurement for the original light source 

 
Figure 21: The acquired spectrum of the reflectance measurement for the silver color metal plate 
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Figure 22: The acquired spectrum of the reflectance measurement for the metallic red color metal plate 

As we can see in the figures above, the silver color metal plate reflects most of the visible 

light, while the metallic red color metal plate mainly reflects the red light. 

 

Checking Colorimetry Information 

When measuring transmittance, reflectance, and a light source, SpectraSmart also 

provides colorimetry information in addition to the measurement graph and the Acquired 

Spectrum. Please refer to "Checking Colorimetry Information" in the chapter of 

transmittance measurement. 

Checking Diagrams 

In addition to colorimetry information, SpectraSmart also provides diagrams for the user 

to check the color coordinates and the dominant wavelength of the test object. Please 

refer to "Checking Diagrams" in the chapter of transmittance measurement. 

Graph Toolbar Buttons 

The toolbar buttons above the reflectance measurement graph are identical to those on 

the transmittance measurement graph, and they work the same way, so we will not 

repeat the details here. Please refer to "Graph Toolbar Buttons" in the chapter of 

transmittance measurement. 
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Saving a Reflectance Measurement 

Saving a reflectance measurement follows the same steps for saving an absorbance 

measurement, so we will not repeat the details here. Please refer to "Saving an 

Absorbance Measurement" in the chapter of absorbance measurement. 

Loading a Previously Saved Spectrum Curve of a Reflectance 

Measurement (And Calculate Colorimetry Info ) 

Loading a spectrum curve of a reflectance measurement is similar to loading that of an 

absorbance measurement, with the same limitation(s), but there is one little difference. 

When loading a spectrum curve from a reflectance measurement, the user can specify 

whether to calculate colorimetry information: 

 

Figure 23: Choosing Calculate colorimetry information when loading a spectrum curve of a reflectance 

measurement  

 

As the former figure shows, after selecting Calculate colorimetry information, you need 
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to specify Observer angle and Illuminant next. With this information provided, you will 

be able to see corresponding data in the Colorimetry and CIE Diagram panes. Apart from 

this difference, all other details are identical to loading a spectrum curve of an 

absorbance measurement. We will not repeat them here. Please refer to "Loading a 

Previously Saved Spectrum Curve of an Absorbance Measurement" in the chapter of 

absorbance measurement. 

 

Deleting Individual Spectrum Curves of a Reflectance Measurement 

A reflectance measurement is composed of multiple spectrum curves. As such, please 

don't delete any individual curve from the measurement as they function as one. Doing 

so will destroy the entire measurement. 

Printing and Previewing a Reflectance Measurement 

The steps for printing and previewing a reflectance measurement are the same as in 

printing and previewing a spectrum measurement. So, we will not repeat the details here. 

Please refer to "Printing and Previewing a Spectrum Measurement" in the chapter of 

spectrum measurement. 
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11. Light Source Measurement 

SpectraSmart can work with spectrometers made by OTO Photonics to measure a light 

source. Such a measurement measures the light source directly, so it does not need a 

reference light. SpectraSmart provides a straightforward procedure to measure a light 

source. All you have to do is follow the step-by-step windows to create a light source 

measurement. 

Creating a Light Source Measurement 

To create a light source measurement, please select Light Source from the Measurement 

menu to open the New Light Source Measurement window, as shown in the following: 

 

Figure 1: Selecting Light Source from the Measurement menu to create a light source measurement 
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Figure 2: New Light Source Measurement—Source Device 

Selecting a Source Device 

Next, please select a source device (identified by its serial number) on the Source Device 

window. Then, click Next. 
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Figure 3: New Light Source Measurement—Color Parameters 

Setting Color Parameters 

When measuring a light source, we need to specify a viewing angle of the CIE Standard 

Observer (Observer angle) and the type of the light source (Illuminant) for accurate color 

measurement. SpectraSmart supports two standard observer viewing angles: 2-degree 

and 10-degree (corresponding to CIE 1931 and CIE 1964 standards, respectively), plus a 

number of standard light sources, as shown in the former figure. Here we choose 

2-degree and D65, and then click Next. 
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Figure 4: New Light Source Measurement—Acquisition Parameters 

Specifying Integration Time 

Next, specify the integration time (i.e. the exposure time for the light sensor) on the 

Acquisition Parameters window. By default, the software automatically sets an 

integration time when this window opens, but this may not fit you needs. If required, you 

can use the preview graph on the lower half of this window to help you determine an 

appropriate integration time. This preview graph updates in real-time as you change the 

integration time. For best results, it is recommended that you specify an integration time 

to allow the highest peak of the curve to fall within the Suggested peak value range. As in 

the figure above, we allow the highest peak to fall within the suggested 40000-60000 

range. 

Note:  In the preview chart of a light source measurement, the curve has also applied 

"Intensity Correction," in addition to "Electronic Dark Correction" and "Linearity 

Correction." For this reason, the intensity of the preview curve here would be 

obviously lower than those in other measurements. Therefore, when you are 
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adjusting the acquisition parameters to make the highest peak fall within the 

suggested 40000-60000 range, please refer to the "Current peak value" field 

instead of the preview chart on this dialog. 

After a few trials and errors, if you still decide that the default value might be the best 

choice, you can simply click Auto Configuration to revert to the original default setting. 

Once the integration time is set, you can continue to set the spectrum scanning interval if 

you need. Please click the Scanning Interval button. On the Spectrum Scanning Interval 

window, select Enable user-defined spectrum scanning interval, and then specify the 

interval you want (the default is 500ms), as in the following: 

 

Figure 5: Spectrum Scanning Interval 

Smoothing 

In addition to the integration time and the scanning interval, you can also choose 

whether to smooth out the curve. This allows you to avoid aberrations in the spectrum 

data by scanning multiple times for averaging. Also, SpectraSmart provides a Boxcar filter 

for additional smoothing. You can use Boxcar width to specify a number of data points on 

both side of the point of interest to include in the calculation of the moving average. This 

smooths out the sharp variations on the curve: the bigger the Boxcar width, the smoother 

the curve. The following figure demonstrates the smoothing effect of a Boxcar width of 10 

(maximum value). You can compare it with the former curve without smoothing to see 

the difference (see the red curve in the preview graph): 

 

www.aptechnologies.co.uk

AP Technologies Limited   The Coach House   Watery Lane   Bath   BA2 1RL 
T:  +44 (0) 1225 780400    F:  +44 (0) 8701 266449    E:  info@aptechnologies.co.uk 

http://www.otophotonics.com/


SpectraSmart User's Guide 11.Light Source Measurement 

OTO PHOTONICS INC. 
 http://www.otophotonics.com/  Page 158 

 

 

Figure 6: New Light Source Measurement—the smoothing effect 

 

Note:  The following example uses the default settings, i.e. no smoothing (Number of 

scans to average=1, Boxcar width=0). 

When all acquisition parameters are set, click Next. 
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圖 7：New Light Source Measurement —Dark Spectrum 

Setting Dark Spectrum 

In addition to the reference spectrum, the software also needs know the readings of the 

light sensor when it is not exposed to light to establish a baseline, i.e. the "dark 

spectrum." So, please cut off or block the light source connected to the spectrometer. 

Then, click on the black-and-white patch on the window to acquire the dark spectrum. 

You can specify the number of scans to average to avoid aberrations of individual scans. 

The default is 1, and we use 10 for example here. Once the dark spectrum is acquired, 

you will see it in the spectrum graph on the lower half of the window, as in the former 

figure. In addition, you will see an "Acquiring dark spectrum..." message window. See the 

following figure: 

 
Figure 8: Acquiring dark spectrum... 
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Aside from capturing the real-time dark spectrum, you can also select the program's 

default dark spectrum or load a previous dark spectrum file you saved with SpectraSmart. 

Please note that the default dark spectrum is a set of built-in data which is handy for 

testing purposes. It may not be suitable for your current measurement environment. The 

following figure shows the case when you choose to Use default dark spectrum: 

 

Figure 9: New Light Source Measurement—Using the default dark spectrum 

 

Note:  This example uses the dark spectrum captured in real-time (not the default dark 

spectrum). 

Once the dark spectrum is set, click Next. 
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Figure 10: New Light Source Measurement—Display Settings 

Display Settings 

Next, you can specify a name for the measurement graph window, as well as a spectrum 

title and a color for the graph, as in the former figure. To specify the color, you can click 

on the color patch and select the desired color from the palette: 
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Figure 11: Display Settings—Color 

When you are done with the display settings, click OK, and then SpectraSmart will display 

the measurement graph. See the following figure: 

 
Figure 12:  Newly created light source measurement graph 

The former picture shows the spectrum of the currently measured light source. Since we 

have specified the type of the light source (i.e. D65) when we created the measurement, 

SpectraSmart automatically adjusted the display range to its wavelength range (380 nm to 

760 nm). 
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Switching to Another Light Source 

Now, let's use another light source for demonstration. We are reusing the current 

measurement but replacing the original light source with a red light. See the following 

figure for the result: 

 
Figure 13: The measurement graph for the red light 

 

Checking the Acquired Spectrum Curve 

Since the light source measurement is calculated based on the spectrum acquired by the 

software, SpectraSmart provides a feature for the user to see the original acquired 

spectrum curve so it can be verified against the measurement curve. Click on the 

Acquired Spectrum button on the toolbar to enable this feature, as shown in the 

following figure: 

 

Figure 14: The Acquired Spectrum button 
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Figure 15: The acquired spectrum of the red light source measurement 

Checking Colorimetry Information 

When measuring transmittance, reflectance, and a light source, SpectraSmart also 

provides colorimetry information in addition to the measurement graph and the Acquired 

Spectrum. Please refer to "Checking Colorimetry Information" in the chapter of 

transmittance measurement. 

Checking Diagrams 

In addition to colorimetry information, SpectraSmart also provides diagrams for the user 

to check the color coordinates and the dominant wavelength of the test object. Please 

refer to "Checking Diagrams" in the chapter of transmittance measurement. 

Graph Toolbar Buttons 

The toolbar buttons above the light source measurement graph are basically identical to 

those on the spectrum graph, with one exception: the Calculated Color Range button. 

See the following figure:  
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Figure 16: The Calculated Color Range button  

For details on how the Calculated Color Range button works, refer to "Graph Toolbar 

Buttons" in the chapter of transmittance measurement. For details on other toolbar 

buttons, refer to "Graph Toolbar Buttons" in the chapter of spectrum measurement. 

Saving a Light Source Measurement 

Saving the current light source measurement follows the same steps for saving the 

current absorbance measurement, so we will not repeat the details here. Please refer to 

"Saving an Absorbance Measurement" in the chapter of absorbance measurement. 

Loading a Previously Saved Spectrum Curve of a Light Source 

Measurement (And Calculate Colorimetry Info ) 

Loading a spectrum curve of a light source measurement is similar to loading that of an 

absorbance measurement, with the same limitation(s), but there is one little difference. 

When loading a spectrum curve from a light source measurement, the user can specify 

whether to calculate colorimetry information: 
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Figure 17: Choosing Calculate colorimetry information when loading a spectrum curve of a light source 

measurement 

As the former figure shows, after selecting Calculate colorimetry information, you need 

to specify Observer angle and Illuminant next. With this information provided, you will 

be able to see corresponding data in the Colorimetry and CIE Diagram panes. Apart from 

this difference, all other details are identical to loading a spectrum curve of an 

absorbance measurement. We will not repeat them here. Please refer to "Loading a 

Previously Saved Spectrum Curve of an Absorbance Measurement" in the chapter of 

absorbance measurement. 
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Deleting Individual Spectrum Curves of a Light Source Measurement 

A light source measurement is composed of multiple spectrum curves. As such, please 

don't delete any individual curve from the measurement as they function as one. Doing 

so will destroy the entire measurement. 

Printing and Previewing a Light Source Measurement 

The steps for printing and previewing a light source measurement are the same as in 

printing and previewing a spectrum measurement. So, we will not repeat the details here. 

Please refer to "Printing and Previewing a Spectrum Measurement" in the chapter of 

spectrum measurement. 
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12. Concentration Measurement 

Spectrum-based concentration measurement captures the spectrum of a light source 

after it passes through the test solution, and then compares the spectrum with the light 

source's original spectrum to come up with the concentration of the solution by applying 

a known calibration table or the Beer's Law. Accordingly, as in the transmittance 

measurement, the user needs to first set up the measurement environment, measure the 

original spectrum of the light source, and then put the test solution in place and measure 

the spectrum of the light passing through the solution. SpectraSmart provides a 

straightforward procedure to measure concentration. All you have to do is follow the 

step-by-step windows to create a concentration measurement. 

Creating a Concentration Measurement 

To create a concentration measurement, please select Concentration from the 

Measurement menu to open the New Concentration Measurement window, as shown in 

the following: 

 

Figure 1: Selecting Concentration from the Measurement menu to create a new concentration measurement 

Then, you will see the following window: 
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Figure 2: New Concentration Measurement—Source Device 

Selecting a Source Device 

On the Source Device window, please select a source device (identified by its serial 

number). Then, click Next. 
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Figure 3: New Concentration Measurement—Acquisition Parameters 

Specifying Integration Time 

Next, specify the integration time (i.e. the exposure time for the light sensor) on the 

Acquisition Parameters window. By default, the software automatically sets an 

integration time when this window opens, but this may not fit you needs. If required, you 

can use the preview graph on the lower half of this window to help you determine an 

appropriate integration time. This preview graph updates in real-time as you change the 

integration time. For best results, it is recommended that you specify an integration time 

to allow the highest peak of the curve to fall within the Suggested peak value range. As in 

the figure above, we allow the highest peak to fall within the suggested 40000-60000 

range. 

Note:  Here, the preview curve has only applied "Electronic Dark Correction" and 

"Linearity Correction" but not "Intensity Correction." So, it may look different 

from the curve in the spectrum measurement because the curve in the spectrum 

measurement has also applied "Intensity Correction." 
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After a few trials and errors, if you still decide that the default value might be the best 

choice, you can simply click Auto Configuration to revert to the original default setting. 

Once the integration time is set, you can continue to set the spectrum scanning interval if 

you need. Please click the Scanning Interval button. On the Spectrum Scanning Interval 

window, select Enable user-defined spectrum scanning interval, and then specify the 

interval you want (the default is 500ms), as in the following: 

 

Figure 4: Spectrum Scanning Interval 

Smoothing 

In addition to the integration time and the scanning interval, you can also choose 

whether to smooth out the curve. This allows you to avoid aberrations in the spectrum 

data by scanning multiple times for averaging. Also, SpectraSmart provides a Boxcar filter 

for additional smoothing. You can use Boxcar width to specify a number of data points on 

both side of the point of interest to include in the calculation of the moving average. This 

smooths out the sharp variations on the curve: the bigger the Boxcar width, the smoother 

the curve. The following figure demonstrates the smoothing effect of a Boxcar width of 10 

(maximum value). You can compare it with the former curve without smoothing to see 

the difference (see the red curve in the preview graph): 
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Figure 5: New Concentration Measurement—the smoothing effect 

 

Note:  The following example uses the default settings, i.e. no smoothing (Number of 

scans to average=1, Boxcar width=0). 

When all acquisition parameters are set, click Next. 
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Figure 6: New Concentration Measurement—Reference Spectrum 

Setting Reference Spectrum 

Next, you need to set a "reference spectrum," which is basically the spectrum of the light 

source before you put the test solution in place. Here, you can click on the color patch on 

the window to acquire the live spectrum as the reference. Or, you can use the Browse 

button to load a previous reference spectrum file you saved with SpectraSmart. In this 

example, we use the default option, that is, acquiring the current live spectrum of the 

light source (as such, please don't put the test object in place). Once the reference 

spectrum is captured, you will see it in the preview graph on the lower half of this 

window. Then, click Next. 
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Figure 7: New Concentration Measurement—Dark Spectrum 

Setting Dark Spectrum 

In addition to the reference spectrum, the software also needs know the readings of the 

light sensor when it is not exposed to light to establish a baseline, i.e. the "dark 

spectrum." So, please cut off or block the light source connected to the spectrometer. 

Then, click on the black-and-white patch on the window to acquire the dark spectrum. 

You can specify the number of scans to average to avoid aberrations of individual scans. 

The default is 1, and we use 10 for example here. Once the dark spectrum is acquired, 

you will see it in the spectrum graph on the lower half of the window, as in the former 

figure. In addition, you will see an "Acquiring dark spectrum..." message window. See the 

following figure: 
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Figure 8: Acquiring dark spectrum... 

Aside from capturing the real-time dark spectrum, you can also select the program's 

default dark spectrum or load a previous dark spectrum file you saved with SpectraSmart. 

Please note that the default dark spectrum is a set of built-in data which is handy for 

testing purposes. It may not be suitable for your current measurement environment. The 

following figure shows the case when you choose to Use default dark spectrum: 

 

Figure 9: New Concentration Measurement—Using the default dark spectrum 

 

Note:  This example uses the dark spectrum captured in real-time (not the default dark 

spectrum). 

Once the dark spectrum is set, click Next. 
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Figure 10: New Concentration Measurement—Display Settings 

Display Settings 

Next, you can specify a name for the measurement graph window, as well as a spectrum 

title and a color for the graph, as in the former figure. To specify the color, you can click 

on the color patch and select the desired color from the palette: 
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Figure 11: Display Settings—Color 

When you are done with the display settings, click OK. SpectraSmart then opens the 

Concentration Settings window, which allows you to specify a known concentration 

response curve or the parameters of Beer's Law for the solution being tested, as shown in 

the following figure: 

 

Figure 12: New Concentration Measurement—Concentration Settings—Calibration Table From Known 
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Concentration 

 

Figure 13: New Concentration Measurement—Concentration Settings—Beer's Law Settings 

Specifying a Known Concentration Response Curve 

The user needs to let SpectraSmart know how to translate the measured spectrum into 

concentration before it can plot the concentration curve for the test solution. There are 

two ways to do this, either by specifying a calibration table (i.e. the response curve) from 

known concentration or specifying the parameters for the Beer's Law, as the former two 

figures show. Setting up the Beer's Law is fairly straightforward. The user should be able 

to figure out how to specify its parameters. As such, the following steps will only 

demonstrate how to create a calibration table: 

1. First, we put a blue-color solution with a known concentration of 0.5 (purely 

hypothetical value) on the test platform. Then, select Specific wavelength in the 

Wavelength area on the Calibration Table From Known Concentration window. 

Also, specify a wavelength of 450.59 (because the solution is blue). 

2. Next, in the Calibration Data area, set the Concentration value to 0.5, and then 

press the Get button to acquire the current absorbance data. 

3. Click the Add to List button to add this value pair to the table on the right. 
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4. Next, place another blue solution with a concentration of 1 (purely hypothetical 

value) on the test platform, and then set the Concentration value to 1 and press 

the Get button again to acquire the absorbance of this solution. 

5. Click the Add to List button to add this value pair to the table on the right. 

Now, you will see a curve in the Regression Graph. This will be the known concentration 

response curve for the solution to be tested: 

 
Figure 14: New Concentration Measurement—Concentration Settings—Configuring concentration response 

curve 

After the response curve is created, you can use the Save Table button on the bottom of 

the window to save this response curve for future use. When you need this curve again, 

just use the Load Table button to load it back. When all settings are done, click Apply to 

apply the settings and the concentration measurement graph will show: 
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Figure 15: Newly created concentration measurement graph 

As we haven't put the test solution in place, what we see on the graph is noise. 

Start Measuring the Concentration of the Test Solution 

Next, we put the test solution in place to measure its concentration. As a demonstration, 

we measure the blue solution we used earlier when we created the calibration table. Its 

concentration graph looks like the following:  

 
Figure 16: The concentration graph of the test solution 
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The concentration graph in SpectraSmart is basically a real-time strip chart which tracks 

the concentration of the test solution. The former picture shows the tracking of about 1 

minute. The red highlighted area is the measured concentration, while the lower part to 

its left is the initial noise. If it is left to keep running, the entire graph will start to scroll to 

the left when the curve hits the right edge. In the figure, the concentration of the test 

solution varies between 0.5 and 0.6. This looks a little bit unstable. So, we can turn on 

smoothing to smooth out the noises in the acquired data and hence stabilize the curve. 

 
Figure 17: Turning on smoothing 

Apparently, the smoothing does help reduce fluctuations, as shown in the red highlighted 

area below: 
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Figure 18: The effect of turning on smoothing 

Checking the Acquired Spectrum Curve 

Since the concentration curve is calculated based on the spectrum acquired by the 

software, SpectraSmart provides a feature for the user to see the original acquired 

spectrum curve so it can be verified against the concentration curve. Click on the 

Acquired Spectrum button on the toolbar to enable this feature, as shown in the 

following figure: 

 
Figure 19: The acquired spectrum of the concentration measurement 
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Graph Toolbar Buttons 

Most of the toolbar buttons above the concentration graph are basically identical to 

those of the strip chart, and they work the same way, so we will not repeat the details 

here. Please refer to "Graph Toolbar Buttons" in the chapter of strip chart. 

Concentration-related Toolbar Button 

Other than those identical to the toolbar buttons of the strip chart, there is a button 

called Concentration Setting that is unique to the concentration measurement. See the 

following figure: 

 
Figure 20: The Concentration Setting button 

The Concentration Setting button opens the window for you to specify the Calibration 

Table From Known Concentration and Beer's Law Settings. 

Saving the Current Concentration Measurement 

Saving the current concentration measurement follows the same steps for saving the 

current absorbance measurement, so we will not repeat the details here. Please refer to 

"Saving an Absorbance Measurement" in the chapter of absorbance measurement. 

Loading a Previously Saved Spectrum Curve of a Concentration 

Measurement 

Loading a spectrum curve of a concentration measurement is similar to loading that of an 

absorbance measurement, with the same limitation(s), so we will not repeat the details 

here. Please refer to "Loading a Previously Saved Spectrum Curve of an Absorbance 

Measurement" in the chapter of absorbance measurement. 

Deleting Individual Spectrum Curves of a Concentration 

Measurement 

A concentration measurement is composed of multiple spectrum curves. As such, please 

don't delete any individual curve from the measurement as they function as one. Doing 

so will destroy the entire measurement. 
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Printing and Previewing a Concentration Measurement 

The steps for printing and previewing a concentration measurement are the same as in 

printing and previewing a spectrum measurement. So, we will not repeat the details here. 

Please refer to "Printing and Previewing a Spectrum Measurement" in the chapter of 

spectrum measurement. 
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13. Trigger Mode Settings  

All OTO spectrometers come with an I/O port to support the so-called "trigger mode," 

which allows the user to control when a spectrometer should start acquiring data by 

sending it an external I/O signal. With this feature, the user can trigger data acquisition 

on multiple devices simultaneously. Instead of sending multiple commands to these 

devices from the computer through software API, triggering acquisition through I/O 

signals can rule out the factor of computer performance, ensuring multiple spectrometers 

to start capturing spectrum data at exactly the same time. 

Trigger Mode 

Normal mode 

Figure 1: Normal mode 
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HW Trigger 

Figure 2: HW Trigger 

 

SW Level Trigger 

Figure 3: SW Level Trigger 
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SW Continuous Trigger 

Figure 4: SW Continuous Trigger 

Enabling the Trigger Mode 

Before using the trigger mode, you need to enable it in SpectraSmart. First, create a 

spectrum measurement, as in the following picture: 

 
Figure 5: Create a new spectrum measurement 

In the Spectrum List pane on the left side of the screen, check to see if the current 

acquisition mode is Normal (by default), as in the following picture: 
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Figure 6: The acquisition mode in the Spectrum List shows Normal 

Next, select Trigger Settings from the Settings menu: 

 
Figure7: Select Trigger Settings from the Settings menu 

The Trigger Settings window shows:  
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Figure 8: Enabling the trigger mode 

Now, follow these steps: 

1. Select the spectrum measurement for which you want to enable the trigger mode 

("Spectrum_0" in this case). 

2. Select your trigger signal type (see the diagram for reference). 

3. Select your TriggerMode (In this case is SW Continuous Trigger mode). 

4. Click the Enable button to put the measurement into the trigger mode. 

5. Click OK to exit this window.  

Now the spectrum acquisition mode should show TriggerMode, as in the following 

picture: 

1 

2 

3 

4
  

2 

5 
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Figure 9: Confirming if the spectrum acquisition mode is now in TriggerMode 

In addition, you will notice that the spectrum graph is not updating anymore because it is 

waiting on the external I/O signal to start data acquisition. 

 

Disabling the Trigger Mode 

To disable the trigger mode, select Trigger Settings from the Settings menu. Then, in the 

Trigger Settings windows, follow these steps: 

1. Select the spectrum measurement for which you want to "disable" the trigger 

mode ("Spectrum_0" in this case). 

2. Select TriggerMode in Normal mode. 

3. Click Enable to put the measurement back to the normal mode. 

4. Click OK to exit this window.  

See the following figure: 
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Figure10: Disabling the trigger mode 

Now, in the Spectrum List pane, you will find that the acquisition mode is back to Normal. 

 

Figure 11: The acquisition mode is now back to Normal 

1 

2 3 4 
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14. Recording and Playing Back Continuous 

Changes of Measurement Values 

In some applications, you might want to monitor a measurement value over a period of 

time to see how it changes. SpectraSmart provides the Time Sequence feature for you to 

do so. It works like video recording. To turn on this feature, go to the Time Sequence 

button on the right edge of the SpectraSmart window. Just hover the mouse cursor over it 

to slide out the Time Sequence pane, as shown in the following figure: 

 
Figure 1: The Time Sequence button and the Time Sequence pane 

When you move the mouse cursor away, the pane closes automatically. If you want it to 

stay on the screen, you can click on the push-pin icon on the upper-right corner of the 

pane to pin it. See the following figure: 

 
Figure 2: The push-pin for pinning the Time Sequence pane 
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When the Time Sequence pane is pinned, SpectraSmart will adjust the layout of its 

window to make room for it, as in the following figure: 

 
Figure 3: The pinned Time Sequence pane 

Start Recording Continuous Changes 

Refer to the former figure. Now we demonstrate how to use the Time Sequence feature 

in a spectrum measurement. 

Specifying a Folder to Save the Captured Data 

First, you need to specify a destination folder to save the recorded data. By default, this is 

the user's desktop. You can change it by using the Save In button on the top of this pane. 

 

Below figure 4 shows normal mode : 
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Figure 4: Normal mode 

 

Setting concept as below figure 

Figure 5: Setting concept 

Specifying When to Start 

Next, you need to specify when to start recording. By default, SpectraSmart starts the 

recording 1 millisecond (ms) after you press the Record button. The recording virtually 

starts right away after you press the Record button. However, please don't set this value 

to zero (0), or there will be an error. 
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Specifying the Acquisition Interval 

You can modify the acquisition interval for the recording. The default interval is 500 ms, 

which means that the data is recorded once every 500 milliseconds. You can specify a 

different interval or choose to synchronize it with the acquisition interval of the original 

spectrum.Below figures show difference : 

Figure 6: Synchronize with the acquisition interval 

Figure 7: Time information in File 

Figure 8: Setup intermal of Timer 
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Figure 9: Time information in File 

Specifying When to Stop 

Next, you need to specify when to stop recording. By default, the SpectraSmart keeps 

recording until you press the Stop button. You can configure it to stop after a period of 

time. 

Specifying What Spectrum Curves to Record 

Finally, you need to specify which spectrum curves you want to record. The default is to 

record all spectrum curves in the current measurement. A typical spectrum measurement 

(as in this case) has only one spectrum curve, but other measurements including 

absorbance, transmittance, reflectance, light source, and concentration have four 

spectrum curves in a single measurement. You can choose to save certain curves without 

saving the reference spectrum and the dark spectrum, for example, the measurement 

curve and the acquired spectrum. It all depends on your needs. In the spectrum list on 

the upper part of this pane, please select the spectrum curves that you want to record. 

Start Recording 

When all selections are done, click the Record (the red dot) button on the top of this 

pane. Now, you will see a message prompt telling you not to change the name of any 

spectrum in this measurement while recording: 

 
Figure 10: The message prompt telling you not to change the name of any spectrum 

Stop Recording 

If you have specified duration for the recording, it will stop by itself when the time is up. If 
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you have chosen to record until you stop it, you need to press the Stop button on the top 

of the pane to stop recording. 

Loading and Playing Back a Previous Recorded Time Sequence 

To load a previously recorded time sequence, go to the File menu, and then select Open 

Time Sequence File. See the following figure: 

 
Figure 11: Selecting Open Time Sequence File from the File menu 

This opens the system standard Open window. Now locate the file you saved earlier, and 

then click the Open button, as in the following figure: 

 
Figure 12: Selecting previously saved file in the Open window 
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Once the file is opened, SpectraSmart will display the playback tools for the time 

sequence file. See the following figure: 

 
Figure 13: The playback tools for the time sequence file 

As the previous figure shows, there are buttons that allow the user to Rewind, Play, 

Pause, and Fast-forward the playback of a time sequence (see the red highlighted area 

near the bottom). These buttons work just like the way they do in video playback. 

Through playback, you can easily go back and forth to find out how the measurement 

reading changes. Moreover, you will notice that the time sequence file will keep playing 

over and over again once it is loaded until you press the Pause button.
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15. Saving and Loading Measurement Settings 

To facilitate repetitive and routine measurements, SpectraSmart allows you to save the 

current measurement settings to a file for future use under identical measurement 

environments or conditions. For demonstration, we create a spectrum measurement, as 

shown in the following: 

 
Figure 1: A sample spectrum measurement 

Saving Measurement Settings 

To save the measurement settings of the current measurement, please select Save 

Measurement Settings from the File menu, as shown in the following figure: 
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Figure 2: Selecting Save Measurement Settings from the File menu 

 

In the Select Spectrum window that appears next, choose which spectrum curve you 

want to save. See the following figure:  

 

Figure 3: The Select Spectrum window 

Select the check box for the spectrum you want (even though there is only one spectrum 

in the list), and then click OK. Next, you will see the standard Save As window, as in the 

following: 
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Figure 4: The Save As window for you to save measurement settings to a file 

Specify the folder and the filename you want (file extension name will be automatically 

set as ".sms"), and then click Save. In the future, when you need to create a 

measurement under the same measurement conditions, you can simply load the settings 

from this file. 

Note:  The current version of SpectraSmart does not support saving strip chart settings 

to a file. You will see an error message when you try to save measurement 

settings for a strip chart. 

 

Loading Measurement Settings 

To load the measurement settings you saved earlier, go to the File menu and select Open 

Measurement Settings File. See the following figure: 
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Figure 5: Selecting Open Measurement Settings File from the File menu 

Next, in the standard Open window, choose the measurement settings file you want to 

load. See the following figure: 

 
Figure 6: The Open window for you to open a measurement settings file 

Once the file is selected and opened, SpectraSmart automatically creates a new 

measurement with the loaded settings. 
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When a Measurement with the Same Name Exists 

As you open a measurement settings file, SpectraSmart creates a new measurement with 

the filename as its title and its window name. So, if there is already a measurement with 

the same name, SpectraSmart will not open the settings file. Instead, it shows the 

following error message: 

 

Figure 7: A measurement with the same name exists 

To avoid this error, you can rename the settings file to any other name, and then open the 

settings file again. 
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16. Application Settings 

In SpectraSmart, there are some application-wide settings that you can customize, 

including the default wavelength display range, the background color of a measurement 

graph, the default smoothing settings, etc. 

 

To change these settings, go to the Settings menu and select Application Settings, as 

shown in the following: 

 

Figure 1: Selecting Application Settings from the Settings menu 

Next, the Application Settings window appears: 

 

Figure 2: The Default Settings tab of the Application Settings 
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Default Settings 

The first tab in this window is Default Settings, which allows you to configure some 

default behaviors of the application. 

Display Range: Start and End 

The Default Settings tab of Application Settings allows you to configure the default 

Display range start and Display range end of the X-axis. This controls the wavelength 

range you see on a measurement graph. 

Average 

This setting allows you specify the default number of scans that SpectraSmart should take 

for averaging when it acquires the spectrum data. Averaging can reduce the influence of 

noise. 

Boxcar 

This setting allows you to specify the default width for the Boxcar smoothing function. It 

varies from 0 to 10, the higher the number, the smoother the curve. The default value is 0, 

i.e. no smoothing. 

Note:  Any change to these default values only affect measurements created after the 

change. Existing measurements are not affected. 

Display a Message when the Peak Value in the Spectrum Exceeds 65535 

The highest supported value in the spectrum data is 65535. So, when the "peak value" of 

the acquired spectrum exceeds this value, it means the spectrum curve is already 

distorted. By default, SpectraSmart displays a warning message to notify the user when 

this happens, as in the following figure: 
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Figure 3: The data distorted warning message 

 

Graph 

This tab allows you to adjust the look of a measurement graph. 

Line Width 

This controls the line width of the curve on a graph. 

Window Background and Chart Background 

These two control the background styles and colors of the measurement window and the 

measurement graph, respectively. The available styles are None, Brush, and Solid:  
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Figure 4: The Graph tab of Application Settings─Window background 

The following figure demonstrates a Window background in solid gray and a Graph 

background in brushed light blue: 

 
Figure 5: Demonstrating background effects in the Application Settings 
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Human Visible Spectrum 

This allows you to show the visible spectrum on the graph along with the measurement 

curve. See the former figure. 

Note:  For these graph settings, you can click "Apply" to see the effect of a change 

immediately. 

Smoothing 

This tab lets you control whether you want to enable smoothing by default. 

 

Figure 6: The Smoothing tab of Application Settings 

Savitzky-Golay Filter 

Here you specify whether to use the Savitzky-Golay filter. To use it, select the Enable filter 

check box, and then specify the smoothing Degree and the smoothing Mode. The 

available modes are Reference Curve, Reference & Measurement Curve, and 

Measurement Curve. 
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FFT Filter 

Here you specify whether to use the Fast Fourier Transform (FFT) filter. To use it, select 

the Enable filter check box, and then specify a Threshold value. 

Running Average 

Here you specify whether to use the running average algorithm. To use it, select Enable 

running average, and then specify the number of points to include in the average. 

Kalman Filter 

Here you specify whether to use the Kalman filter. To use it, simply select the Enable filter 

check box. 

DWT Denoise Filter 

Here you specify whether to use the Discrete wavelet transform denoise filter (DWT 

Denoise Filter). To use it, simply select the Enable Filter check box. 

Long Pass Filter 

Here you specify whether to use the high pass filter. To use it, simply select the Enable 

filter check box. 

Note:  You can click "Apply" to see the effect immediately after you change these 

smoothing settings. 

Color Information  

Here you can customize the fields displayed in the Colorimetry pane. See the following 

figure: 
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Figure 7: The Color Information tab of Application Settings 
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17. Other Miscellaneous Features 

In addition to the main features described in previous chapters, there are a few other 

miscellaneous features in SpectraSmart that allow you to work more easily. 

Language 

SpectraSmart allows you to change its display language in real-time. Just go to the File 

menu, and then select Language: 

 

Figure 1: Selecting Language from the File menu 

Once you select the language you want, the user interface will switch to the chosen 

language immediately. For demonstration, we change the language to Traditional Chinese 

in the following figure: 
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Figure 2: The effect of switching the display language to Traditional Chinese 

Font 

In addition to the display language, you can also adjust the size of the font for the user 

interface. Go to the View menu, and then select Font: 

 
Figure 3: Selecting Font from the View menu 

You can choose the font size that best fits your needs. 

 

Default Layout 

Once you have more than one measurement windows and you have moved the windows 

around, you can go to the Window menu and select Default Layout to revert to their 

default layout: 
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Figure 4: Selecting Default Layout from the Window menu 

The window layout now reverts back to the way it originally was: 

Figure 5: The default window layout of the program 
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18. Program Version and Contact Information 

This concludes our introduction to all features of SpectraSmart. Hopefully, these chapters 

will help you get up to speed with SpectraSmart as a new user. If you have any further 

questions about SpectraSmart or any suggestions to this guide, please don't hesitate to 

let us know. You can find our contact information in SpectraSmart by going to the Help 

menu then selecting About. You will see the version information of your SpectraSmart as 

well as our contact information: 
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Appendix A: Spectrometer Correction Features 

Electronic Dark Correction  

A basic electric current constantly flows through the electronic systems (such as the main 

board and the CCD sensor) of the OTO spectrometer whenever the spectrometer is on. 

This is called the "dark current," meaning this current exists even though no light enters 

the spectrometer. The analog-to-digital converter (ADC) will also convert this dark current 

into measurement readings across the entire spectrum, forming the baseline. Before 

shipment, an OTO spectrometer will be factory-calibrated to an assumed baseline of 

1,000 as the dark current. Since the dark current is not triggered by the light entering the 

spectrometer, this baseline needs to be deducted from the readings. As the level of the 

dark current can be affected by the device temperature, OTO has designed an algorithm 

to dynamically correct the readings in relation to the dark current. This is called the 

"electronic dark correction," a process which each OTO spectrometer must go through 

before shipment, and the correction data is directly stored within the spectrometer. 

When the electronic dark correction is enabled in the SpectraSmart software, the dark 

current will be dynamic removed from the measurement curve. The following figures 

show two different measurement curves without and with electronic dark correction, 

respectively: 

 
Figure 1: Without electronic dark correction 
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Figure 2: With electronic dark correction 

To enable electronic dark correction in SpectraSmart, click on the Electronic Dark 

Correction button above the toolbar. To disable it, just click on the button again. See the 

following figure: 

 

Figure 3: The Electronic Dark Correction button 

 

Linearity Correction 

The response curve of the CCD sensor in relation to the light intensity is not a perfect 

straight line. In addition, the response curve of each CCD sensor will not be identical to 

each other. For this reason, each OTO spectrometer will go through a "linearity 

correction" process before it is shipped, with its own correction table store within the 

spectrometer. As OTO spectrometers uses an 16-bit ADC internally, its output readings 

will be calibrated to the range between 0 and 65535. When linearity correction is enabled 

in the SpectraSmart software, the reading for each pixel will be corrected using this table. 

See the following figure for the difference: 

 

www.aptechnologies.co.uk

AP Technologies Limited   The Coach House   Watery Lane   Bath   BA2 1RL 
T:  +44 (0) 1225 780400    F:  +44 (0) 8701 266449    E:  info@aptechnologies.co.uk 

http://www.otophotonics.com/


SpectraSmart User's Guide Appendix A: Spectrometer Correction Features 

OTO PHOTONICS INC. 
 http://www.otophotonics.com/  Page 217 

 

 
Figure 4: Without linearity correction 

  
Figure 5: With linearity correction 

To enable linearity correction in SpectraSmart, click on the Linearity Correction button 

(next to the Electronic Dark Correction) above the toolbar. To disable it, just click on the 

button again. See the following figure: 

 

Figure 6: The Linearity Correction button 

 

Intensity Correction 

In OTO spectrometers, not only does the CCD sensor responds to light intensity in a 

non-linear manner, each pixel also responds differently to different wavelengths. So, each 

OTO spectrometer also goes through an "intensity correction" process, with its own 

correction table stored within the spectrometer. OTO uses the standard lamp from 

Industrial Technology Research Institute (ITRI) of Taiwan in the intensity correction 

process, so OTO is able to calibrate the intensity response of the sensor across the 
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spectrum based on the standard absolute light intensity. This also enables the calibration 

of absolute light intensity on the SMA905 connector side (350-900nm). However, if 

customers need to set up absolute light intensity measurements using their own systems, 

intensity correction tables must be created for such systems. The following figures 

demonstrate two different measurement curves without and with intensity correction, 

respectively: 

 
Figure 7: Without intensity correction 

 
Figure 8: With intensity correction 

To enable intensity correction in the SpectraSmart software, click on the Intensity 

Correction button above the toolbar. See the following figure: 

 
Figure 9: The Intensity Correction button 
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Appendix B: Light Source Operation 

SEC 2020 series spectrometer is equipped with standard SEC 2022 

light source 

 

 
Figure 1: Light Source Switch Function Configuration 

Manual Mode Operation step  

Step.1 After plugging the +12V power to the Deuterium-Halogen (DH) light source, user 

can turn on the main power by the Main Power Switch. The Power Green LED will be 

lightening “ON”.  

Step.2 Then user can select the Auto/Manual Switch. Once the manual mode is selected; 

that means the switch is at the left position.  

Step.3 After manual mode is selected, user can turn on/off the D2, Halogen, or Shutter 

function by sliding the switches.  
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Auto Mode Operation  

Step.1 Put the Spectrometer and the Deuterium-Halogen (DH) light source on the 

platform and place them at the assigned  measurement position.  

Step.2 Plug in the 8pin cable to link these two devices. Please make sure the cable is 

inserted correctly.  

Step.3 Plug the USB cable to connect the spectrometer and the PC.  

Step.4 After plugging the +12V power to the DH light source, user can turn on the main 

power by the Main Power Switch. The Power Green LED will be lightening “ON”. 

Step.5 Slide the Auto mode switch to the right position. The “Auto” Green LED will be 

lightening "ON”. 

Step.6 Then user can use the OtO’s software SpectraSmart or SDK to send the command 

to turn on/off the D2, Halogen light source, or Shutter function individually; the 

corresponding Green LEDs will be turned on/off accordingly.  

Step.7 User needs to consider the warming-up and stable time for DH light source. 
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Figure 2: Spectrometer and light source set up with cable connection 

I/O Extension Port Pin# Description Alt Function 

        There is one 8pin 2.0mm pitch connector with every DH light source. This 8pin 

connector can connect SmartEngine (SE) series spectrometer and DH light source directly 

to operate auto mode. Once the operation mode is selected to Auto mode, D2, Halogen 

light source and Shutter function will be controlled by the I/O level. (3.3V/5V or 0V).  

 

Pin No. Direction Pin Name Function Description 

1 NC NC NA 

2 NC NC NA 

3 NC NC NA 

4 Input Shutter 
High: Open Shutter Low: Close 

Shutter 

5 Input D2_ON High: Turn on D2 LS. Low: Turn off. 

6 Input HAL_ON 
High: Turn on Halogen LS. Low: Turn 

off. 

7 NC NC No connection inside the LS-DH-1. 

8 GND GND GND 
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